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The research focused on the use of the displacement discontinuity method to 

simulate cracking behavior of the indirect tension strength test of asphalt mixtures.   

From numerical experiments, it was found that the granular structure of asphalt mixtures 

could be best represented by Voronoi tessellations with internal fracture paths.  Two 

distinct crack growth rules, SEQUENTIAL and PARALLEL, were evaluated and no 

difference was found in terms of the predicted crack patterns and stress strain responses.  

However, the PARALLEL crack growth rule that activates all crack sites when the stress 

exceeds failure limit is more efficient than the SEQUENTIAL crack growth rule that 

activates the most overstressed crack site one at a time.  The study of the aggregate size 

effects revealed a small size effect.  An increase in average aggregate diameter from 4.5 

mm to 12.0 mm increased the ultimate tensile strength of the specimen by 11%.  It was 

also found that the optimal particle size was around 40 to 60% passing of gradation.   

xiii 



The sensitivity analysis of material parameters revealed that the mastic properties were a 

key factor controlling the cracking behavior of mixtures.   

Finally the method was used to simulate crack propagation of three mixtures and 

evaluate their tensile strength and fracture energy density.  The numerical results showed 

reasonable predictions of crack patterns and stress strain responses.  The predicted tensile 

strength and fracture energy density were acceptable. 
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CHAPTER 1 
INTRODUCTION 

1.1 Background 

It has long been accepted that cracking of hot-mix asphalt (HMA) pavements is a 

major mode of premature failure.  A solid understanding of the mechanisms of crack 

initiation and crack growth is essential to predict pavement performance in the context of 

thickness design, as well as in the design and optimization of mixtures.  Any hope of 

developing more crack resistant mixes relies on improved understanding of the 

mechanics of crack initiation and crack growth in HMA mixtures.  Unfortunately, the 

complexity of modeling crack initiation and crack growth has been an obstacle to the 

incorporation of fracture mechanics-based approaches in the bituminous pavement area. 

With an increasing of computer power, numerical analysis of cracking becomes 

possible. Bazant (1986) provided a good review for cracking models that have been used 

for granular material such as concrete and rocks.  Cracking in material is normally 

analyzed by either a fracture mechanics approach or smeared crack approach.   

The former assumes a single line of crack initiates from a pre-existing flaw and 

propagates through material according to a certain crack growth criterion such as 

maximum energy release rate.  In contrast, the latter assumes cracks are smeary 

distributed over a finite region such that an average tensile strain can adequately 

represent crack.  Even though fracture mechanics and smeared crack approaches can 

predict cracking behavior, they do not really capture the characteristic of cracks in 

1 
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granular material in which cracks randomly initiate at critical locations and coalesce, 

forming major crack bands.  

Explicit fracture modeling using random assemblies of displacement discontinuity 

boundary elements provides a more realistic approach for analyzing discrete cracks in 

granular material (Napier, 1990; Napier and Hildyard, 1992; Napier and Pierce, 1995(a-

b); Malan and Napier, 1995; Kuijpers and Napier, 1996; Napier et al., 1997; Napier and 

Malan, 1997, Steen et al., 2001, Birgisson et al., 2002(a-b) and Soranakom et al., 2003).  

The method takes advantage of the known solutions of displacement discontinuity in an 

infinite medium to formulate system of equation; thus, the method is efficient and yields 

good results for crack-type problems.   

The change of geometry due to crack propagation in material can easily be handled 

by placing displacement discontinuity elements along the anticipated crack paths, which 

are normally assumed at the boundaries of the grain particles and perhaps internal to the 

grains as well.  Another advantage of using the boundary element approach is that the 

dimension of the problem decreases by one.  That means a two-dimensional problem 

needs one-dimensional element with a simple failure law; therefore, the computational 

cost is greatly reduced.  For the advantages mentioned above, this method provides an 

elegant way to simulate and analyze cracks in asphalt mixtures. 

1.2 Problem Statement 

The displacement discontinuity boundary element method has successfully been 

used in the field of rock mechanics and mining engineering to model the cracking 

behavior in rock mass and/or excavations underground.  Based on this work, it was 

determined that the method had the potential to be used in the field of pavements to study 

the effects of cracking on asphalt mixtures.  Since no previous work has been performed 
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on the use and implementation of this method to simulate and evaluate the cracking 

behavior of asphalt mixtures, several questions regarding the appropriate set of numerical 

components arise, which are summarized below:  

• What is the best tessellation schemes to simulate the cracking behavior of asphalt 
mixtures?  This includes the type of tessellation scheme (Delaunay triangles, 
Voronoi polygons or Vornonoi with internal fracture paths) and the optimal particle 
size used in tessellations to represent aggregate structure of IDT specimen.    

• Identification of appropriate crack growth rules for using in simulation of cracking 
behavior of mixtures.  This includes an evaluation of appropriate numerical 
schemes for predicting the crack growth.  Currently, two basic schemes have been 
evaluated, namely the SEQUENTIAL and PARALLEL crack growth rules.  In the 
PARALLEL crack growth rule, all elements that reach failure in any given loading 
step are allowed to crack.  In the SEQUENTIAL crack growth law, only the most 
overstressed element is allowed to crack, and the resulting redistribution of stresses 
is performed and the process is repeated until all overstressed elements at any given 
load step have been allowed to crack.   

• Evaluation of the current failure law implemented in the boundary element code 
DIGS. In the displacement discontinuity boundary element method, all nonlinear 
behavior is lumped into the displacement discontinuity.  The rest of the material is 
considered linear elastic.  This allows for the formulation of various local “failure 
laws” to simulate the fracture behavior of materials.  For example, a typical 
assumption would be that the local failure in a sliding mode at a given 
displacement discontinuity is governed by a Mohr-Coulomb failure law, such that 
once the stress state reaches the failure envelope, sliding is initiated.  Similarly, in 
tension, a typical failure law would be that the material would open in tension once 
a given local tensile strength criteria is reached.  The nature of these failure laws 
can be very flexible, allowing for peak- and residual strength criteria, with 
degradation laws describing the transition from the peak strength to the residual 
strength. 

• It is also important to determine consistent means of obtaining key material 
parameters for mixtures.  This includes the identification of parameters that can be 
obtained directly from existing laboratory testing procedures, as well as from 
calibration.  In particular, any parameters that need to be obtained from calibration 
need to be scrutinized in terms of the consistency of the calibration approach used 
from one mixture to another.      

• The potential of the method needs to be evaluated in terms of how well it captures 
key mixture characteristics and trends observed under carefully controlled 
laboratory testing conditions.   In particular, to what extent this method can predict 
cracking behavior of asphalt mixtures in the laboratory is of interest.  This includes 
determining how well the method can simulate 
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o The pre- and post-peak stress-strain behavior under tensile loading conditions 

o The initiation of fracture 

o The fracture energy and tensile strength at the point of fracture 

1.3 Research Hypothesis 

The displacement discontinuity boundary element method with an appropriate 

tessellation scheme can be used to simulate the observed cracking behavior of asphalt 

mixtures in the laboratory under controlled loading and environmental conditions.  

Therefore, it is possible to identify an appropriate set of model conditions to describe the 

fracture behavior of HMA from a micromechanical point of view.   

1.4 Objectives 

The objectives of this research are summarized below: 

• Identify the appropriate tessellation schemes and optimal particle size to simulate 
aggregate structure of asphalt mixtures.  

• Identify the appropriate crack growth rule for simulating indirect tension strength 
test under monotonic loading conditions. 

• Evaluate the performance of the current Mohr-Coulomb type of failure to model 
cracking behavior of mixture. 

• Establish numerical calibration procedure to obtain material parameters from a 
given mixture. 

• Evaluate the potential of using displacement discontinuity method with tessellation 
to determine tensile strength and fracture energy density of mixtures 

1.5 Scope 

This study focuses on the implementation of the displacement discontinuity method 

to the field of pavements.  The project will start with a study to identify the appropriate 

tessellation schemes and crack growth rules.  Then, the study will focus on the evaluating 

the sensitivity of stress-strain predictions to the various input parameters used.  These 

include material parameters for the mastic, material parameters for fracture path inside 
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aggregate, and the determination of the optimal average size of aggregates.   

The sensitivity of these parameters will be used to establish a standard numerical 

procedure to simulate indirection strength test.  Finally, the numerical model will be used 

to simulate and evaluate how well the method can predict mixture properties such as 

tensile strength and fracture energy density.   

1.6 Research Approach 

The research was conducted in five phases: 

• Learning how to use the boundary element code entitled “Discontinuity Interaction 
and Growth Simulation” (DIGS). 

• Writing pre-and post processors to help input data and interpret results from DIGS 

• Conducting the following numerical studies: 

o Compare tessellations schemes (Delaunay, Voronoi and Voronoi with internal 
fracture paths). 

o Compare crack growth laws (SEQUENTIAL and PARALLEL). 

o Evaluate the current failure law, which is a Mohr Coulomb type of failure law 
by means of evaluating the sensitivity of material parameters used on the 
resulting predictions of the stress-strain behavior of mixtures. 

o Evaluate any potential aggregate size effects. 

• Establishing a numerical procedure to calibrate material properties from a given 
mix for use in a numerical model to simulate indirect tension strength test. 

• Using numerical models to evaluate tensile strength and fracture energy of three 
mixtures: Nova Scotia, NW39_1C and I95SJN_BW. 

 

 



 

CHAPTER 2 
LITERATURE REVIEW 

2.1 Overview 

The purpose of this chapter was to conduct a literature review of commonly used 

approaches in the analysis of cracking and damage in asphalt mixtures.  Another popular 

analytical tool, displacement discontinuity method, which has been used to analyze 

cracking in field of rock mechanics, was also reviewed.  The four approaches that the 

literature review focuses on are: 

• Classical fatigue approach  

• Continuum damage approach 

• Fracture mechanics approach 

• Displacement discontinuity approach with tessellation schemes 

2.2 Classical Fatigue Approach 

Fatigue cracking due to repeated traffic loading is one of the major distresses in 

asphalt concrete pavements.  The mechanism of fatigue cracking is caused by the tensile 

stress at either the top or the bottom of asphalt layer induced by wheel load.  With several 

number of load passes, microcracks will develop and later coalesce to form major crack 

bands, weakening the pavement structure and finally leading to pavement failure.   

In order to characterize the fatigue resistance of a mixture for pavement design, it 

was necessary to describe the behavior of AC mixtures under repeated stress or strain 

cyclic loading.  In early developments, many researchers have proposed fatigue models to 

predict the number of load passes to failure based on the tensile strain at the bottom of the 
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asphalt layer alone.  Later on, the models have been improved by including other related 

variables such as mixture stiffness and volume of bitumen in the mix. 

The Illinois Department of Transportation presented a strain-based equation for 

pavement thickness design based on the studies of Thompson and Cation (1986), Gomez 

and Thompson (1984), and Thompson (1987).  The equation had accounted for mixture 

composition factors, field calibration and split strength characteristics.  The following 

equation was developed for a particular dense-graded mixture used at Illinois DOT 

0.3
6 1105 






×= −

εfN         (2-1) 

where Nf is the number of repetitions to failure and ε is the maximum tensile strain. 

Based on extensive laboratory test data covering a wide range of mixtures, 

bitumen’s, and testing conditions, The Royal Dutch Shell Oil Company (Bonnaure et al., 

1980) developed separate fatigue models for constant stress and constant strain beam 

fatigue tests.  For constant stress tests, number of repetitions to failure can be defined as 

( )[ ] 4.1550167.000673.000126.00252.0 −−−+−= mtbbf SVVPIPIN ε   (2-2) 

where PI is the penetration index, Vb is the percentage of bitumen volume in the mix, Sm 

is the stiffness modulus of the mix in N/m2 and εt is the tensile strain, which was defined 

by  

( )[ ]
2.0

6

28.0

9
6

10105
1004.2471.982.143.36

−−
−

















×
×−+−= fm

bbt

NS
VVPIPIε   (2-3) 

In a very similar format, the number of repetitions to failure for constant strain can 

be defined as 

( )[ ] 8.155112.00454.00085.017.0 −−−+−= mtbbf SVVPIPIN ε     (2-4) 
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and the tensile strain εt was defined by 

( )[ ]
2.0

6

36.0

10
6

10105
1004.2471.982.143.36

−−
−

















×
×−+−= fm

bbt

NS
VVPIPIε   (2-5) 

The Asphalt Institute (1982) also developed a fatigue equation, which accounted 

for the asphalt volume and the percent air voids in the mixture.  The equation was based 

on the constant stress criterion, which can be expressed as 

854.0*291.300432.0
−−= ECN tf ε         (2-6) 

where C is the correction factor defined by 

MC 10=    

and   







−

+
= 69.084.4

ba

b

VV
V

M   

By assuming a standard mix with an asphalt volume Vb of 11% and air void volume 

Va of 5%, which makes M = 0 and C = 1.  Also multiplying the equation with  

a factor of 18.4 to account for the difference between laboratory and field condition,  

the final fatigue criterion then becomes 

854.0*291.30796.0
−−= EN tf ε         (2-7) 

where E* is the dynamic modulus.  

Even though several fatigue equations have been proposed so far, none of them 

include all the variables that may affect the fatigue failure on asphalt mixtures.   

The discrepancy between the number passes to failure predicted from laboratory testing 

and those observed in the field can be very large due to several environmental variables 

such as varying temperature and resting period.  The studies conducted by Francken 

(1979) found that the fatigue life of asphalt mixtures increased with longer rest periods.  
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Despite the imperfections of the proposed models mentioned so far, the method still 

provide practical solutions to approximate the failure life of pavements while waiting for 

a more rational mechanistic design.  

2.3 Continuum Damage Approach 

The continuum damage approach approximates the progression of fatigue cracking 

in asphalt concrete as a reduction of stiffness due to damage incurred by repeated 

loading. Lee and Kim (1998a) proposed a viscoelastic constitutive model for asphalt 

concrete under cyclic loading, which was based on three mechanisms: 

• Damage due to micro and macrocracks 

• Relaxation of stress in viscoelastic material 

• Healing effect of asphalt concrete 

Lee and Kim employed the extended elastic-viscoelastic correspondence principle 

(Schapery, 1984) to convert viscoelastic stress-strain relationships to stress (σ) pseudo 

strain (εR) relationships such that undesirable relaxation effects in the mixture were 

removed.  According to the theory, small tensile loading that does not cause damage in 

material yields a linear relationship of stress pseudo strain 

R
RE εσ =           (2-8) 

where ER is the reference modulus, which is an arbitrary constant. 

Higher tensile loading that causes damage in material will change the stress pseudo 

strain from a linear relationship to a nonlinear response with a hysteresis loop.  The 

pseudo stiffness SR, which defined as the ratio of a stress value to a pseudo strain value at 

the peak pseudo strain of each cycle, decreases as repeated loading continues.  The 

material is considered to fail when the stiffness is reduced to 50% its original value.   
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Lee and Kim proposed a viscoelastic constitutive model for asphalt concrete under cyclic 

load, which was applicable for both stress and strain control 
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where I is the initial pseudo stiffness, =  – , which  is the pseudo strain and 

 is the shift of pseudo strain (for stress control mode),  =  – , which  is 

the largest  during the  history up to the current time, F(S
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representing the change in normalized pseudo stiffness, Sn = Sp/Sf, which Sp is the 
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Lee and Kim (1998b) extended their model by including the healing effect that 

prolonged fatigue life.  The healing function was added to the existing model, which was 

briefly presented in a simple form 

R
eHGFI εσ ][ ++=          (2-10) 

where I is the initial pseudo stiffness, F is the function for change in pseudo stiffness,  

G is a function account for the hysteretic behavior of stress-pseudo strain relationship and 

the H is the function account for healing effect, =  – , which  is the pseudo 

strain and  is the shift of pseudo strain (for stress control mode).   

R
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The application of continuum damage approach was first used to evaluate modified 

and unmodified mixtures for Inchon airport pavements in Korea, Lee, Daniel and Kim 

(2000).  In their work, they used uniaxial tensile test results with cyclic loading to 

construct the relationship between the number of cycles to failure and strain amplitude.  

By using elastic layered analysis of the pavement structure, the tensile strain at the 

bottom pavement can be calculated and used to rank the fatigue life of each mixture.   

The best mixture was then recommend for the airport project. 

The continuum damage approach provides another way to assess the fatigue 

resistance of mixtures. The method was rational and applicable for both stress and strain 

control modes.  The model was suitable for testing and evaluating mixtures for each 

project.  However, by looking at cracks as continuum damage, the method lacks 

characteristics associated with the presence of a physical crack such as stress 

concentration ahead of crack tip and stress redistribution due to crack growth. Therefore 

the approach may only be suitable for design purposes, but not for analysis of fracture. 

2.4 Fracture Mechanics Approach 

The science of fracture mechanics was first introduced by Griffith (1920), 

explaining a quantitative connection between fracture stress and flaw size.  Griffith 

invoked the first law of thermodynamics to formulate a fracture theory based on a simple 

energy balance.  According to his theory, the crack will increase in size if sufficient 

potential energy is greater than the surface energy of the material.  Since then, several 

researchers embraced fracture mechanics concepts to quantify fracture toughness of 

asphalt mixtures and develop fracture mechanics-based models to predict crack growth in 

materials.  The fracture mechanics approach used in the field of pavements will be 
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reviewed under two subtopics: conventional fracture mechanics and the application of 

fracture mechanics. 

2.3.1 Conventional Fracture Mechanics 

Asphalt concrete is known as viscoelastic-plastic and temperature dependent 

material.  Under certain conditions such as at low temperature and high strain rate, the 

material behavior can be approximated with elastic analysis; therefore, early work in the 

field of pavement fracture mechanics assumed that Linear Elastic Fracture Mechanics 

(LEFM) is applicable.  Material characterization with the fracture mechanics approach 

normally is conducted in two ways: monotonic loading and cyclic loading.  Monotonic 

loading is used to determine critical stress intensity (KIc), which refers to fracture 

toughness of the tested mixtures.  The cyclic loading is also performed to obtain fatigue 

test data for fitting material parameters to specific fatigue cracking models. 

There are several test setups that are possible for obtaining the critical stress 

intensity factor (KIc) for asphalt concrete.  Winnie and Wundt (1958) proposed the 

following equation for determining KIc ( mPa ) under three point bending test 

BK cIc
2521.0 σ=          (2-11) 

where σc is an applied critical remote bending stress (Pa), B = (d-a) (mm), d is a depth of 

the beam (mm), and a is a crack (notch) depth (mm). 

Ewalds and Wanhill (1986) used a collocation method to derive the formula for 

determining fracture toughness KIc under three points bending test  

)(2/3 d
af

bd
PlK Ic =          (2-12) 
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where P is a maximum load on the load deflection curve (N), l is a span of the beam 

(mm), b is a width of the beam (mm), d is a depth of the beam (mm),  f(a/d) is a function 

of crack geometry  = A/B, with 
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Under normal circumstances, traffic and thermal loading create a stress intensity 

factor (KI) less than the critical stress intensity (KIc); therefore, no sudden failure occurs.  

However, a pavement does crack due to repeated loading.  Paris and Erdogan (1963) first 

discovered the power law relationship for fatigue crack growth in material, which is 

commonly known as Paris law 

( )nKA
dN
da

∆=           (2-13) 

where da/dN is the crack growth rate (mm/cycle), ∆K is the range of stress intensity 

factor (Mpa-mm0.5) during repeated loading condition, and A and n are material 

parameters determined from fitting fatigue test data.   

Since the introduction of Paris’s law, there have been several proposed models 

embedded into the da/dN – ∆K relationship. Weertman (1966) developed an alternative 

semi-empirical equation 

2
max

2

4

KK
KC

dN
da

Ic −
∆

=         (2-14) 

where Kmax is the maximum service stress intensify factor.  

Forman (1967) proposed the following equation 
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1
max

1

−

∆
=

−

K
K

KC
dN
da

Ic

m

          (2-15) 

where C and m are the material constants 

Elber (1970) proposed a modified Paris law 

m
effKC

dN
da

∆=           (2-16) 

where ∆Keff is the effective stress intensity range, defined as Kmax – Kop; in which Kop is 

the stress intensity factor at which the crack open. 

Klesnil and Lukas (1972) also proposed a modified Paris law to account for  

a threshold 

( m
th

m KKC
dN
da

∆−∆= )          (2-17) 

where the threshold (∆Kth) is a fitting parameter to be determined from a fatigue test. 

It is important to note that all Eq.2-13 through Eq.2-17 were not developed from 

basic mechanics considerations.  They are empirical relationships containing two or more 

constants, which can be determined from experimental test data.  

A more mechanics-based model was developed by Ramsamooj (1980).  He used the 

nonlinear differential equation governing subcritical growth of a crack embedded in an 

elastic-plastic matrix up to the point of gross instability, derived by Wnuk (1971), to 

formulate a fatigue crack growth model for a beam on elastic foundation 

( 4
0

4
2224

KK
KdN

da
I

tIc

−∆=
σ

)π         (2-18) 

where σt is the yield stress in flexural tension, KI is stress intensity at service load and Ko 

is the value of stress intensity at endurance limit. 
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Ramsamooj (1991) then again used the same nonlinear differential equation with an 

estimated value of plastic zone for asphalt concrete ∆ = 0.125(KI/σt)2 to formulate a 

general expression for fatigue behavior of asphalt concrete under any configuration of 

loading and boundary conditions 
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Zhang (2000 and 2001) used fracture mechanics principles with linear 

viscoelasticity to develop a fatigue crack growth model for crack propagation in IDT with 

center hole specimen under repeated loading.  The approach utilized the concept of a 

plastic zone ahead of crack tip to accumulate damage for each cycle of loading.  For the 

haversine 0.1 seconds load pulse, with a 0.9 second rest period; the damage due to 

dissipated creep strain energy (DE) per cycle is determined as follows 

( ) ( )∫=
1.0

0

.
10sin10sin dttt

cycle
DE

pavg πεπσ       (2-20) 

where σavg is an average stress in the zone of interest, is a maximum creep strain rate 

determined from 100 second creep test.  According to the energy threshold concept 

introduced by Zhang (2000), the process zone ahead of the crack tip will accumulate 

damage, described by dissipated creep strain energy, for each cycle of loading until a 

dissipated creep strain energy threshold is reached.  If the damage level exceeds the 

energy limit, macrocracks will propagate for the length of the process zone.  On the other 

hand, if the damage level stays below the threshold, only microcracks develop and they 

are healable after a resting period.  With this energy threshold concept, the model 

.

pε
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predicted the progression of cracks in a stepwise manner similar to the crack propagation 

observed in laboratory. 

2.3.2 Application of Fracture Mechanics 

Since the fracture mechanics approach has been well accepted for analyzing crack 

growth in material, many researchers have adopted the concepts and applied them to the 

field of pavements.   

Jacobs (1995 and 1996) used fracture mechanics principles to characterize fracture 

toughness and construct master curves for various tested mixtures.  He conducted 

uniaxial static testing of double edge notch specimen (50x50x150mm) to obtain 

maximum tensile strength (σm) and fracture energy (Γ).  He also conducted the fatigue 

tests of the double edge notch specimen to determine material parameters A and n.  

According to his research, he concluded that theoretical derivations for A and n for 

viscoelastic materials by Schapery (1973, 1975, 1978) appeared to be valid 
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m
n 112   for force controlled tests; and 

m
n 2

=   for displacement controlled tests 

where I1 is a result of the integration of stress near the crack tip over a small region ahead 

of the crack tip known as the failure zone, ν is a Poisson ratio, D(t) = Do+D2tm with, Do is 

an initial creep compliance, D2 is the t = 1 sec. intercept of a line drawn tangent to the 

double-log creep compliance {D(t)-Do} vs. time plot, t is a current time, m is a slope of 
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double-log creep compliance vs. time plot, ∆t is the period of loading to complete one 

cycle of loading, w(t) is the wave shape of the stress intensity factor. 

Ramsamooj (1993) modified an analytical solution for a thin plate resting on elastic 

foundation by including 3 cracking conditions: crack through in transverse direction; 

crack through in longitudinal direction and semi elliptical crack at the bottom of the plate.  

The formulas can be used to evaluate stress intensity ahead of crack tip for those three 

types of cracking in pavement.  

Collop and Cebon (1995) investigated the causes of cracking on the top and bottom 

layer of an asphalt concrete pavement.  According to their findings, the transverse contact 

traction may cause a short crack (10 mm) on the pavement surface and the repeated 

bending tensile stress caused crack at the bottom.  They then formulated an analytical 

solution for determining stress intensity factor for a surface crack in a semi-infinite plate 

subjected to a general remote stress. They also derived a formula based on parametric 

studies to quantify the stress intensity factor due to traffic and thermal loading for various 

pavement structures at progressive crack growth in pavement.  

Myers et al. (2000 and 2001) also investigated the mechanism of surface initiated 

cracking along the wheel path but they used measured tire contact stresses instead of the 

traditionally assumed circular load.  According to their findings, the surface cracking was 

caused by transverse shear stress of a radial tire and perhaps combined with thermal 

stress due to rapid cooling.  Then they used a fracture mechanics approach with the finite 

element software ABAQUS to study the propagation of top down cracking.  By assuming 

cracks propagate perpendicular to the major principal (tensile) stress, they found the 

cracks grew down vertically in the pavement and then bent 30 degrees toward the wheel 
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load.  The predicted crack path was found similar to what has been observed in the field.  

They also performed parametric studies to quantify the stress intensity factor ahead of the 

crack tip for various load positions, stiffness ratios and thickness ratios for progressive 

crack growth in a flexible pavement. 

Sangpetngam (2003) has adopted a crack growth model developed by Zhang (2000 

and 2001) into a displacement discontinuity boundary element-based pavement fracture 

simulator.  He used crack tip elements to improve accuracy of stress distribution ahead of 

crack tip and replaced the process zone with yield element.  The implementation of crack 

growth model in the numerical scheme increases the application of fracture mechanics for 

predicting crack growth in asphalt mixture for various geometries, loading and boundary 

conditions. 

The use of fracture mechanics approach to analyze cracking in material is suitable 

for problems that experience either a single line or a few distinct lines of fracture.  The 

mechanics of stress concentration and stress redistribution ahead of crack tip that play an 

important role to the failure in material are very well established.  However, the accurate 

modeling of actual distributed crack bands found in granular materials is still missing in 

conventional fracture mechanics. 

2.5 Displacement Discontinuity Method with Tessellation Schemes 

The displacement discontinuity method developed by Crouch (1983) has been 

extensively used in the fields of rock mechanics and geological engineering.  The method 

has the potential to be an analytical tool for assessing cracking in granular materials such 

as asphalt concrete.  The clear advantage of using this method to analyze crack type 

problem is that cracks can be explicitly modeled in the medium and the accuracy of stress 

ahead of crack tip is very good.   

 



19 

The method can be modified to simulate cracking in granular material by creating a 

numerical model with two types of elements: exterior boundary elements and potential 

crack elements.  The exterior boundary elements are placed along the boundary of a 

problem to simulate the edge of specimen and potential crack elements are randomly 

placed inside specimen to simulate predefined crack paths, which normally is assumed to 

be along the grain boundary or perhaps through grain as well. 

The displacement discontinuity boundary element method can be used coupled with 

various tessellation schemes.  The use of tessellations to represent granular structure in 

simulation of fracture process zone is very well accepted.  It improves the realism of 

predicted failure mechanisms at the particle level.  Two basic tessellation schemes 

Delaunay and Voronoi have been used in various fields.  Both tessellations can be used to 

simulate polycrystalline of ductile material such as Ostoja-Starzewski (1987), Ostoja-

Starzewski and Wang (1989), Van der Burg and Van der Giessen (1993), Helms, Allen 

and Hurtado (1999).  The tessellation schemes are also applicable to simulate granular 

structure of brittle rocks such as Napier and Peirce (1995), Napier et al. (1997), Sellers 

and Napier (1997) and Steen, Vervoort and Napier (2000).  The suitable choice of 

tessellations to represent granular structure depends on the realistic looks of failure 

pattern and observed responses. 

Napier and Peirce (1995) invented a new boundary element solution technique, 

termed the “multipole method” for solving multiple interacting crack problem that 

involved several thousands boundary elements.  They used the new technique to study the 

different failure mechanisms of a rectangular rock sample under displacement control 

using two tessellations schemes (Delaunay and Voronoi) for three levels of grain 
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densities.   It appeared that Voronoi assemblies are less prone to shed load than the 

Delauney triangulations.  With increasing the density of Voronoi polygons, it seemed to 

not change this conclusion. 

Steen, Vervoort and Napier (2001) took a similar approach but with 3 tessellation 

patterns, Delaunay, Voronoi and Voronoi with internal fracture path to simulate a 

confined compression test of a rock sample.  It found that the use of Voronoi tessellations 

with internal fracture paths best simulated the formation of shear band in the specimen.  

The Delaunay tessellation scheme was the second best while the Voronoi tessellation was 

not able to predict observed shear banding.  The experiments also tested the use of two 

failure criteria; Rankine criterion (Chen and Han 1988) and Coulomb failure criterion to 

identify the appropriate failure law that allowed the formation of shear bands.  The result 

of the simulation revealed that only Coulomb failure criterion enabled localization of 

shear band. 

Birgisson et al. (2002a) first introduced the displacement discontinuity boundary 

element method to simulate crack growth in Superpave IDT specimens.  They used 

exterior boundary elements to create a 2D plain stress specimen and randomly laid down 

potential crack elements forming Voronoi tessellation inside the specimen.  With an 

appropriate set of material parameters for local failure at potential crack elements, the 

numerical prediction can capture stress strain responses and crack pattern.  Birgisson et 

al. (2002b) continued studying the tessellation schemes and crack growth rules for 

simulating crack growth in asphalt mixture. They found that the Voronoi tessellation with 

internal fracture path provided realistic simulation of crack growth in asphalt mixture 

because aggregate is allowed to break down at high load level, which results better fit of 
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stress strain responses.  The results of using different two crack growth rules, sequential 

and parallel, are not significant, but the parallel crack growth rule that activates several 

cracks at a time is more efficient than the sequential crack growth rule that activates 

crack one at a time.  

Soranakom et al. (2003) used the same numerical schemes as Birgisson et al. 

(2002b) to evaluate mixture properties.  They found that the method was capable of 

evaluating mixture properties with acceptable accuracy. The predicted results matched 

vertical compressive stress strain curve, horizontal tensile stress strain curve, crack 

pattern, tensile strength and fracture energy of the mixes.  

The displacement discontinuity method with tessellation scheme as predefined 

crack paths has demonstrated its ability to simulate crack propagation in granular material 

such as asphalt concrete. The use of appropriate tessellation to represent grain structure 

improved the realism of distributed crack in granular material that macrocracks were 

accompanied by several microcracks. 

2.6 Summary 

From the literature review presented above, it was concluded that the most 

appropriate approach for studying the cracking behavior of asphalt mixtures was the 

displacement discontinuity method with tessellation schemes.  The approach provides an 

elegant way to model aggregate and mastic separately such that the detail of aggregate 

structure and strength of mastic can be investigated.  The approach can be used to 

identify the key factors that control the cracking mechanism in asphalt mixture.  The 

understanding of microstructure and its cracking behavior will provide the rational 

recommendation for improving crack resistant mixture.  

 



 

CHAPTER 3 
DISPLACEMENT DISCONTINUITY METHOD WITH TESSELLATION SCHEME 

3.1 Overview 

Displacement discontinuity method (DDM) is an indirect boundary element method 

developed by Crouch (e.g. Crouch and Starfield, 1983).  The displacement discontinuity 

boundary element method is uniquely well suited for dealing with problems involving 

fracture and crack growth.  Even though the method is inherently simple to use and very 

flexible for many kinds of problems in various fields of engineering, it has received little 

attention compared to the well-known finite element and finite different methods.  These 

are some reasons:   

• The misconception that boundary element method is derived for a particular class 
of problems, and it cannot be applied to other classes of problems.  The method 
may in fact be easily modified for solving other problems.  

• Theoretical papers on boundary element method are viewed by many engineers as 
being somewhat abstruse and sometimes difficult to understand, due to the heavy 
mathematical detail required.  Thus, the complexity of the mathematics involved in 
deriving the system of equations may have been an obstacle in the proliferation of 
the boundary element method. 

The intention of this chapter is to provide a theoretical background of the 

displacement discontinuity boundary element method to solve problems involving 

fracture of materials, particularly cracking in the indirect tension specimen. 

3.2 Displacement Discontinuity Method 

A physical crack in material can be viewed as a discontinuity surface.   

The displacement discontinuity method assumes displacements in a body are continuous 

everywhere except at a line of discontinuity (Figure 3-1).  When the displacement crosses 

22 



23 

the line of discontinuity, its value jumps by the amount of the displacement discontinuity 

Di, in which its components in local axis coordinates y-z are 

)0,()0,( +− −= qiqiqi yuyu)(yD  i = y, z;  -b< yq <b   (3-1) 

where z = 0+ is the positive side and z = 0- is the negative side of the discontinuity 

element. 
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Figure 3-1. Displacement discontinuity element in local coordinate (y-z). A linear 

discontinuity element has a total length of 2b with two collocation points  
(c1 and c2) at y = + b2)2( .  The distance r is measured from the field point 
p(yp,zp) in the domain to the source point Q(yq,0) at boundary. 

In two-dimensional plane strain problems, if the line of discontinuity has a length 

of 2b, centered on the y-axis of a local coordinate system y-z, and has normal vector 

components ny and nz along the surfaces, it can be shown (Peirce and Napier 1994) that 

the contribution of a given element to the total displacement components at point p is 
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where uy, uz are the local components of the displacement vector, ν is Poisson ratio and 

the symbols in the matrix are given by 

yzzyyyyL ,, )2()1( Ψ−+Ψ−= νν  

zzzyyzyM ,, )1( Ψ−+Ψ−= νν  

yzzyyyyN ,, )1( Ψ−−Ψ= νν  

zzzyyzzL ,,)1( Ψ+Ψ−−= νν  

yzzyyyzM ,,)1( Ψ−Ψ−= νν  

zzzyyzzN ,, )1()2( Ψ−+Ψ−= νν        (3-3) 

The biharmonic function for plain strain problem is given by  

)log(
2
1 222 rrr −=Ψ   and     (3-4) 222 )( pqp zyyr +−=

It can also be demonstrated (Peirce and Napier 1994) that, the contribution of the 

element to the total stress tensor components at point p is 
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           (3-5) 

For numerical implementation, the displacement discontinuity Di is approximated 

by a polynomial function, y = a0 + a1x1 + a2x2 + … + anxn.  More accurate results can be 

obtained by using several terms in the approximation, but it will increase computing time.  

It is sufficient for most practical applications to approximate the displacement 

discontinuity with a linear function as was done in the Discontinuity Interaction and 

Growth Simulation (DIGS) program, (Napier, 1990; Napier and Hildyard, 1992; Napier 
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and Pierce, 1995a; Malan and Napier, 1995; Kuijpers and Napier, 1996; Napier at el., 

1997; Napier and Malan, 1997). The linear variation of discontinuity can be written as 

qiiqi ybayD +=)(    ai and bi are constants    (3-6) 

By substituting Eq.3-6 into Eq.3-5, and carrying out the mathematical 

manipulation, the analytical solution for normal stress on the y-axis of the local 

coordinate system (y-z) will have the form: 
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It is obvious from Eq.3-7 that the analytical normal stress σzz approaches infinity as 

y approaches the tip of the element y = + b.  However, in boundary element formulations, 

stress in Eq.3-7 is evaluated at suitable collocation points y = + c, namely the Gauss-

Chebyshev points (Crawford and Curran, 1982) 

n
iyi 2

)12cos( π
−=   i = 1, 2 …, n     (3-8) 

The stresses at collocation points will have finite values and are solvable using a 

numerical algorithm. 

3.3 Numerical Implementation 

For numerical implementation, the displacement discontinuity method (DDM) 

employs the known solutions of the discontinuity surface to formulate a system of 

governing equations.  For a problem with one crack in the infinite elastic body without 

far field stresses, the general system of governing equations can be written as: 
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where  and  are the shear and normal stress of the element i. , ,  and  

are the influence coefficients due to element j on element i, and and  are the 

displacement discontinuity components of element j, which are the unknowns of the 

system. 
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In simulations of crack interaction problems, a displacement discontinuity element 

will slide when driving shear stress exceeds shear strength or open up when applied 

tensile stress exceeds tensile strength.  Even if the DDM was initially developed for an 

open crack, it can easily be extended to include contacting crack surfaces and sliding 

cracks in softening mode. 

When two crack surfaces are in contact, the shear and normal stress components 

 and  depend on the stiffness (Ki
sσ i

nσ s and Kn) and the displacement discontinuity 

components ( and ).  The relationships can be written in matrix forms as follows i
s
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i
n DK=σ          (3-10) 

By substituting Eq.3-10 into Eq.3-9 and rearranging the terms so that the unknowns 

are on the right hand side, the system of governing equations then becomes 
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When an element mobilizes, the crack surface will deform according to softening 

models, which will be described shortly in the next section.  The residual strength of the 
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element i, namely  and  can be assumed to decrease as a function of the 

displacement discontinuities and , which can generally be expressed by 
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Substituting Eq.3-12 in Eq.3-9, and rearranging the unknowns to the right hand 

side, the system of equations becomes 
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Finally, a set of algebraic equations that consist of known driving forces, influence 

coefficients and the unknown displacement discontinuities can be written in a matrix 

form, {σ}  = [A]{D}.  Since the mobilization of cracks is associated with a softening 

model in which stresses depend on the unknown discontinuities, an iterative technique 

needs to be employed in solving the equations.  DIGS use an efficient multi-pole method 

(Napier and Peirce1995a) for iterative solving.  Once displacement discontinuities at all 

boundary elements have been determined, displacements and stresses at any designated 

points can be computed by using Eq.3-2 and Eq.3-5. 

3.4 Example of a Crack Growth Model using DIGS 

A numerical model for a Superpave indirect tension test (IDT) specimen consists of 

two types of elements: exterior boundary elements and potential crack elements.  The 

exterior boundary elements are regular boundary elements that are employed to construct 

an edge of a specimen.  Potential crack elements on the other hand allow the element to 

mobilize (slip or open up) when the stress exceeds a failure limit.  Therefore, they are 
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randomly placed inside the specimen to form any desired tessellations to represent 

granular structure.  Figure 3-2 shows examples of using three tessellations, Delaunay, 

Voronoi and Voronoi with internal fracture paths, to simulate the aggregate structure of 

an IDT specimen. 

During the analysis, at each load step, stresses are computed at collocation points 

inside potential crack elements.  The stress state at these locations is then checked against 

a failure limit to determine the activation of a crack.  In DIGS, a nonlinear failure law, 

shown in Figure 3-3, is adopted for the cracking criterion.  The failure law consists of a 

linear portion in the compression region (similar to the Mohr-Coulomb failure law) and a 

power law curve in the tension region, with a continuous slope at σn = 0.  The linear 

portion has the following form 

nS σφτ )tan(−=  when σn <0      (3-14) 

where S is the cohesion, φ is the friction angle and σn is the normal stress (tension 

positive) across the discontinuity.  The power law curve is defined by: 

b
nta )( σστ −=  when σn > 0      (3-15) 

where σt is the tensile strength and the two constant “a” and “b” are the parameters that 

fit the power law curve to the tension cutoff To at shear stress σs = 0 and the linear 

portion at normal stress σn = 0. 
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           A                                             B                                           C 
 
Figure 3-2. Tessellations for granular structures. Aggregate structure in indirect tension 

specimen can be represented by three basic tessellations:  A) Delaunay,  
B) Voronoi and C) Voronoi with internal fracture path. Each tessellation has 
503 particles, which yields an equivalent aggregate size of 6.8 mm. 
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Figure 3-3. Mohr Coulomb type of failure criterion for determining crack mobilization. 
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For every load step, a crack search algorithm is performed to detect cracks that may 

occur in the specimen.  There are two crack search algorithms available in DIGS, namely 

parallel and sequential.  The parallel crack search activates all elements where the stress 

exceeds the failure limit.  Alternatively, the sequential crack search activates only the 

most overstressed element found in system; thus, only the most critical crack element is 

activated.  At the end of each search step, the detected cracks are added to the system and 

resolved for new stress pattern to determine new cracks in the next search step, until no 

more cracks found.   

When potential crack element turn into a cracked state, the cohesion S is assumed to 

weaken as a linear function of the slip Ds 

|| ssofto DCCS −=         (3-16) 

where Co is the original cohesion intercept and Csoft is the cohesion softening slope.  

Similarly, the tensile strength σt is also assumed to weaken as a linear function of the 

opening displacement Dn 

|| nsoftot DTT −=σ         (3-17) 

where To is the tension cutoff and Tsoft is the tension softening slope.  When crack slip 

occurs, the tensile strength is implicitly degraded as the cohesion softens, congruently 

with the extent of cohesion softening. The tensile strength completely gone when the 

opening crack (Dn) exceeding the opening crack limit (DNCR) 

 



 

CHAPTER 4 
NUMERICAL EXPERIMENTS OF THE SUPERPAVE INDIRECT TENSION TEST 

USING THE DISPLACEMENT DISCONTINUITY METHOD WITH  
A TESSELLATION SCHEME 

4.1 Overview 

This chapter provides the results of a series of parametric studies that 

systematically evaluate the factors and parameters needed to successfully simulate the 

SUPERPAVE indirect tension (IDT) strength test.  The appropriate set of tessellation and 

crack growth rules are identified, and the use of different grain sizes to represent actual 

gradation was also conducted to identify the optimal size that would yield the most 

consistent result for numerical simulations.  Finally, a sensitivity study of material 

parameters defined for mastics and aggregate were performed to study their effects on the 

load-deformation and cracking behavior in the IDT strength test.   

Since the displacement discontinuity method can be used to simulate different 

kinds of materials such as rock, concrete and asphalt concrete, a typical IDT test result of 

granite mixture (Nova Scotia NS619) was used to provide the target for modeling asphalt 

concrete.  First, the input parameters (global and micro-mechanics-based parameters) for 

the displacement discontinuity boundary element method were calibrated so that the 

resulting predicted stress-strain curves matched the experimental curves.  Then each 

component and material parameter was altered from the calibrated fit model to observe 

the sensitivity of the predicted results (stress-strain curves) and identify the best 

combination.  The scopes of numerical studies were summarized below. 

• Determination of appropriate tessellation schemes and crack growth rules 

31 
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• Determination of uniform aggregate size to represent gradation 

• Sensitivity analysis of material parameters defined for mastics 

• Sensitivity analysis of material parameters defined for internal fracture path 
(aggregate): 

After performing all analysis stated above, the appropriate set of tessellation, crack 

growth rules and material parameters were proposed for numerical simulation of indirect 

tension strength test. 

4.2 Laboratory Experiment of Nova Scotia Mixture 

A SuperPaveTM IDT strength test at 0°C was performed to obtain the experimental 

results used in this study.   The IDT specimen was prepared according to the 

SuperPaveTM specifications.  The aggregate used was granite from Nova Scotia.  The 

gradation shown in Table 4-1 was used to design a 19-mm (0.75 in) nominal maximum 

aggregate size coarse-graded mix.  AC-30 asphalt was used with the design content of  

5.5% at Ndesign = 109 revolutions in the SuperPaveTM gyratory compactor.  The asphalt 

and the aggregate were mixed at 150 °C (302°F) and subjected to short-term oven aging 

for two hours at 135°C (275°F).  For the strength testing, specimens were compacted to 

produce three 4500 g (9.9 lbs), 152.4 mm (6 in) diameter gyratory compacted specimens 

with an air void content of 7% (+ 0.5%).  All aggregate and volumetric properties of the 

mixture met SuperPaveTM requirements. 
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Table 4-1. Gradation of the Nova Scotia mixture 
Sieve size (sieve number) Percent passing
25 mm (1) 100 
19 mm (3/4) 97 
12.5 mm (1/2) 83 
9.5 mm (3/8) 66 
4.75 mm (#4) 38 
2.36 mm (#8) 23 
1.18 mm (#16) 18 
600 µm (#30) 14 
300 µm (#50) 10 
150 µm (#100) 6.5 
75 µm (#200) 3.5 
 

The gyratory compacted specimens were sliced to obtain SuperPaveTM IDT test 

specimens, with an approximate diameter of 152.4 mm (6 in) and 50.8 mm (2 in) 

thickness.  The IDT strength test was performed according to the SHRP Indirect Tension 

test procedure, presented by Roque et al (1997).  A summary result of IDT strength test is 

shown in Table 4-2. 

The applied load, horizontal and vertical deformation measured at each face of a 

sample can be represented by horizontal and vertical stress strain curves at the center 

using IDT plane stress formula as follows 

σh = 2P/(πDt) 

εh = ∆H/Lgauge          

σv = 6P/(πDt) 

εv = ∆V/Lgauge         (4-1) 

where, σh is a horizontal stress at the center of specimen, P is a total load applied, D is a 

diameter of a specimen, t is a thickness of a specimen, εh is an average horizontal strain 
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over a horizontal strain gauge, ∆H is a corrected horizontal deformation at a horizontal 

strain gauge, Lgauge is a gauge length, σv is a vertical stress at the center of specimen, εv is 

an average vertical strain over a vertical strain gauge, and ∆V is a corrected vertical 

deformation at a vertical strain gauge.  Finally, the horizontal and vertical stress strain 

curves on each face of the sample were averaged and used for comparison to the 

numerical prediction, which will be described shortly in the next section. 

Table 4-2. Material properties from IDT strength test 
 

 

Parameters Value 
Tensile strength (MPa) 2.05 
Fracture energy (MPa) 0.83 
Poisson ratio  0.35 
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A     B  

Figure 4-1. Indirect tension strength test: A) Experimental setup and B) Displacement 
discontinuity model. 

4.3 Numerical Simulations 

The experimental setup and the associated numerical model for the Superpave IDT 

strength test are shown in Figure 4-1.  The specimen size is 152.4 mm (6”) in diameter 

and varying in thickness (T mm).  Two end plates 25.4 mm x T mm (1” x T”) at the top 
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and the bottom are used to protect the damage to specimen due to high concentrated load.  

At the center of specimen, two strain gauges 38.1 mm (1.5”) are placed in the vertical and 

horizontal directions to measure vertical and horizontal deformations in the central zone. 

Figure 4-1B shows an IDT numerical sample using Voronoi with internal fracture 

path to represent aggregate structure.  Four field points (acting like virtual strain gauges) 

are placed at the locations of the actual strain gauges to monitor the displacements at each 

load step.  The perimeter of the numerical model is comprised of 152 exterior boundary 

elements.  Of those, 8 elements are placed at the top and forced to move downward to 

simulate displacement control.  Other 8 elements at the bottom are fixed to provide a 

static condition.  The remaining 136 elements along the circumference are specified with 

zero traction to simulate traction free surface. 

The displacement controlled loading was performed in 12 equal steps for a total 

displacement of 0.36 mm.  For perfect displacement control, the predicted stress 

distributions at the load plates are nonuniform and they become significantly fluctuated 

when crack approaches the end plates.  For the comparison to the actual testing results, 

the applied load was approximated by the average stress at the top and bottom plates 

multiplied with the plate area.  The horizontal and vertical deformations in the center part 

of the specimen can be obtained by determining the relative movement of the 

displacements requested at the virtual strain gauges.  Finally, the predicted stress strain 

curves for horizontal and vertical direction were computed and represented in the same 

way as the experiment by using Eq.4-1. 

4.4 Determination of Suitable Tessellation Schemes and Crack Growth Rules 

The identification of an appropriate tessellation scheme and crack growth rule was 

an iterative process since the effects of other relevant components such as particle size 
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and material parameters for the mastic and aggregate were not yet fully known.  Several 

attempts to model IDT strength test Birgisson et at (2002 a-b) and Soranakom (2003) had 

previously been performed in which it was shown that it was possible to fit the stress 

strain curves and correctly predict the crack pattern observed in the laboratory.  However, 

some issues still needed to be studied further, namely the establishment of a 

representative optimal Voronoi particle size for a given gradation, and other issues 

related to the “tuning” of the micromechanical material parameters.   In the following, the 

insight gained from previous work (Birgisson, et al., 2002a-b) will be used to identify a 

suitable tessellation scheme and crack growth rule. 

4.4.1 Numerical Experiment 

Three tessellations Delaunay triangulation, Voronoi polygons and Voronoi 

polygons with internal fracture paths, shown in Figure 3-2, were used to model the 

aggregate structure of the Nova Scotia mixture.  Each tessellation has 503 particles filling 

the circular area of 18240 mm2, which yields an equivalent aggregate size of 6.8 mm or at 

D50 (aggregate size at 50% passing of the gradation).  All three tessellation schemes were 

used to simulate the Superpave IDT strength test.  The predicted stress-strain curves and 

crack patterns were then compared to the experimental results obtained for the Nova 

Scotia mixture.  For each tessellation scheme, two crack growth rules, parallel and 

sequential, were compared.  The modeling matrix, global and local material parameters 

used for the numerical experiments are provided in Table 4-3 through Table 4-5.  It is 

note that material parameters defining mastic strength and its residual strength for 

Delaunay tessellation are substantially higher than those for Voronoi and Voronoi with 

internal fracture path in order to ovoid unstable collapsing and produce the best fit to the 

experimental stress strain curves. 
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Table 4-3. Modeling matrix for the study of suitable tessellation schemes and crack 
growth rules 

 Tessellation schemes 
 

Delaunay Voronoi 
Voronoi with 

internal fracture 
path 

Crack growth rule Parallel Sequential Parallel Sequential Parallel Sequential
Equivalent aggregate size 
(mm) 6.8 6.8 6.8 6.8 6.8 6.8 
Number of potential crack 
element for mastic 720 720 1408 1408 1408 1408 
Number of potential crack 
element for fracture path  - - - - 2717 2717 
 

Table 4-4. Global linear elasticity parameters for the study of suitable tessellation 
schemes and crack growth rules 

Parameter Value 
Young modulus (MPa) 7500 
Poisson ratio 0.35 
 

Table 4-5. Local material parameters for the study of suitable tessellation schemes and 
crack growth rules 

 Tessellation schemes 
 

Delaunay Voronoi 

Voronoi with 
internal fracture 

paths 

Material parameters Mastic  Mastic  Mastic 

Internal 
fracture 
pahts 

Tension cutoff, To  (MPa) 4.00  2.30  2.30 6.50 
Opening crack limit, DNCR (mm) 0.15  0.11  0.11 0.07 
Tension softening slop, Tsoft (MPa/mm) 26.67  20.91  20.91 92.86 
Cohesion, Co (MPa) 4.00  2.40  2.40 6.50 
Residual cohesion, CR (MPa) 1.00  0.15  0.15 0.15 
Cohesion softening slop, Csoft (MPa/mm) 0.50  5.00  5.00 1.00 
Friction angle, φo (degree) 45  38  38 40 
Residual friction angle, φR (degree) 44  30  30 32 
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4.4.2 Results from Numerical Simulations 

The result of the numerical simulations will be discussed in the next four sections 

entitled: Crack growth rules, Delaunay tessellations, Voronoi tessellations, Voronoi 

tessellations with internal fracture path, followed by a summary of findings for the 

optimal crack growth rule and suitable tessellation scheme. 

4.4.2.1 Crack Growth Rules 

Figure 4-2 shows the amount of cracking predicted by the two crack growth rules: 

parallel and sequential.  Both predicted approximately the same number of cracks for all 

load steps up to the load step at the peak of the stress-strain curves (load step 10 for the 

Delaunay tessellation scheme, load step 9 for Voronoi tessellation scheme and Voronoi 

with internal fracture path scheme (Figure 4-3 – 4-5).  In the post peak region, the 

sequential crack growth rule predicted fewer cracks than the parallel did.  Parallel and 

sequential crack growth rules also yielded approximately the same stress strain responses 

up to the peak, but started to deviate slightly in the post peak. The small differences in the 

post-peak stress-strain response were due to the differences in predicted post-peak crack 

patterns. 

Figure 4-6 shows a comparison of the predicted crack patterns obtained with the 

three tessellations and the two crack growth rules studied.   All the predicted crack 

patterns showed similar patterns - a major vertical opening crack in the middle region of 

the specimen, accompanied by several smaller size cracks, distributed over a wider band 

through the center of the specimen.  Overall, two crack growth rules yielded 

approximately the same result for both predicted stress strain responses and crack 

patterns.  However, the sequential crack growth rule that activates the most overstressed 
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element one by one is more computationally intensive than the parallel crack growth rule 

that activates all overstressed elements at the same time.  Thus, in the following, the 

parallel crack growth rule is used in all remaining simulations. 
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Figure 4-2. Predicted number of cracks at each load step. Three tessellations, Delaunay, 
Voronoi and Voronoi with internal fracture path were used with two crack 
growth rules, Parallel and Sequential 
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Figure 4-3. Comparison of predicted and measured horizontal and vertical stress-strain 
curves, using Delaunay tessellation: A) Horizontal stress-strain response at 
center of specimen and B) Vertical stress-strain response at center of 
specimen. 
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Figure 4-4. Comparison of predicted and measured horizontal and vertical stress-strain 
curves, using Voronoi tessellation: A) Horizontal stress-strain response at 
center of specimen and B) Vertical stress-strain response at center of 
specimen. 
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Figure 4-5. Comparison of predicted and measured horizontal and vertical stress-strain 
curves, using Voronoi with internal fracture path tessellation: A) Horizontal 
stress-strain response at center of specimen and B) Vertical stress-strain 
response at center of specimen. 
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Figure 4-6. Crack patterns predicted by two crack growth rules of three tessellations:  
A) Delaunay, C) Voronoi and C) Voronoi with internal fracture path. 
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4.4.2.2 Evaluation of Delaunay Tessellation Scheme 

Figure 4-6A shows a crack pattern predicted by a Delaunay tessellation scheme.  

The dominant large crack pattern is similar to those predicted using the Voronoi 

tessellation schemes (Figure 4-6B and 4-6C).  The narrower band of distributed cracks, as 

compared to the Voronoi schemes is simply the result of using higher strength and 

residual strength of the mastics.  In Delaunay scheme, cracks appearing on one side of a 

triangular particle were able to work their way to the other side easily, creating floating 

particles (particles completely surrounded by cracks), which weaken aggregate structure 

in carrying compression load.  In some cases, these “floating particles” occurred in the 

area of the virtual strain gauge points, resulting in almost a rigid body motion.  This 

unstable movement could be minimized by increasing the residual strength parameters of 

the mastic in the model. 

In order to use the Delaunay tessellation structure to model the IDT strength test, 

substantially higher mastic strength than Voronoi tessellations and Voronoi tessellations 

with internal fracture path was needed.  Despite using the best possible set of material 

parameters, the Delaunay can only obtain a rough match to the experimental stress strain 

responses as shown in Figure 4-3, the predicted stress-strain curves were not smooth and 

did not fit very well.  The parameters for residual strength were unreasonable high for 

such a brittle material asphalt concrete.  Therefore, it was concluded that the use of 

Delaunay tessellation scheme to model the aggregate structure for the Nova Scotia 

asphalt mixture studied was unsuccessful. 

4.4.2.3 Evaluation of Voronoi Tessellation Scheme 

Figure 4-6B shows the crack pattern at the final load step predicted using the 

Voronoi tessellation scheme to represent the aggregate structure of the Nova Scotia 

 



45 

mixture.  Multiple cracks formed a wide band of cracks, within which, the material 

appeared to form a columnar structure defined by the overall cracking pattern.  Those 

“broken columns” were still able to provide some strength in carrying compressive load 

from the top to the bottom of the specimen.  This mechanism resulted in a simulated 

compressive softening of the ascending (near peak) portion of the predicted vertical stress 

strain curve (Figure 4-4B).  At higher load levels, the number of distributed cracks and 

the size of opening crack increased, resulting in a rapidly decreased strength.  Once the 

major opening cracks occur, the strength of specimen was diminished.  By specifying 

appropriate values of residual strength parameters, the simulations were able to capture 

the post peak stress-strain response.   Finally, the simulations of IDT strength test using 

Voronoi tessellation schemes revealed a difficulty in tuning the material properties for the 

mastics to adequately match experimentally observed peak and post peak load 

deformation responses. 

4.4.2.4 Evaluation of Voronoi with Internal Fracture Paths Tessellation Scheme 

Figure 4-6C shows the predicted crack pattern at the final load step predicted using 

a Voronoi tessellation scheme with internal fracture paths to represent aggregate 

structure.  The predicted cracking patterns were similar to that obtained from the Voronoi 

tessellation scheme, except that some of the aggregates broke down at high load levels.  

The additional parameters for defining the aggregate can be modeled such that the 

predicted stress strain responses (Figure 4-5) can fit to the experimental results better.  

Finally, the Voronoi tessellations with internal fracture paths seemed to reasonably 

represent the observed load deformation behavior of the granular structure of the Nova 

Scotia mixture. 
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4.4.3 Summary of Findings on the Determination of a Suitable Crack Growth Rule and 
Tessellation Scheme 

From the results presented, the use of Voronoi tessellations with internal fracture 

paths and the parallel crack growth rule resulted in reasonable simulations that 

corresponded with experimental stress strain curves and fracture patterns. 

4.5 Determination of Average Voronoi Aggregate Size to Represent Gradation 

4.5.1 Numerical Experiment 

This study was conducted to identify the optimal aggregate size for the simulation 

of IDT strength test.  A Voronoi tessellation scheme with internal fracture path (medium 

size 8.0 mm) was first tuned to match the experimental stress strain curves for the Nova 

Scotia mixture to obtain the material parameters needed to describe the mastic and the 

internal fracture paths of the aggregates.  Once the appropriate material parameters for 

the asphalt concrete had been determined, a series of numerical IDT strength test 

simulations was performed using five uniform aggregate sizes 4.5, 6.0, 8.0, 10.0 and 12.0 

mm.   For more reliable test result, three samples were performed to obtain average value 

for each aggregate size.  The averaged ultimate tensile strength and variance of residual 

error of the tensile stress strain curves were used to evaluate the size effects and the 

associated variability.   All details of the numerical models and material parameters used 

for the study of the aggregate size are listed in Table 4-6 through Table 4-8. 

 



 

Table 4-6. Modeling matrix for the study of size effect:  
 Agg. 4.5 mm Agg. 6.0 mm Agg. 8.0 mm Agg. 10.0 mm Agg. 12.0 mm 

Tessellation 
Voronoi with 

internal fracture 
path 

Voronoi with 
internal fracture 

path 

Voronoi with 
internal fracture 

path 

Voronoi with 
internal fracture 

path 

Voronoi with 
internal fracture 

path 

Crack growth 
rule Parallel     

     

     

                

        

      

Parallel Parallel Parallel Parallel

Equivalent 
aggregate size 
(mm) 

4.5 6 8 10 12

Exterior 
boundary 
elements 

152 152 152 152 152

Sample No. 1 2 3 1 2 3 1 2 3 1 2 3 1 2 3

Potential crack 
elements for 
mastic 

3129 3123 3128 1826 1837 1829 1012 1165 1015 681 685 682 517 505 505

Potential crack 
elements for 
fracture path in 
aggregate 

6168 6157 6163 3551 3569 3554 1923 3090 1929 1261 1269 1263 933 910 910

47
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Table 4-7. Global linear elasticity parameters for the study of size effect  
Parameter Value 

Young modulus (MPa) 7500 

Poisson ratio 0.35 
 
Table 4-8. Local material parameters for the study of size effect 
Potential crack 
element 

To     
(MPa) 

DNCR 
(mm)

Tsoft 
(MPa/mm)

Co    
(MPa)

CR    
(MPa)

Csoft 
(Mpa/mm) 

φo       
(degree) 

φR     
(degree)

Mastic 2.40 0.11 21.82 2.40 0.20 1.00 38 30 
Internal 
fracture path 6.40 0.10 64.00 6.40 0.30 1.00 38 30 
 
4.5.2 Numerical Results 

Figure 4-7 shows the averaged predicted horizontal and vertical stress strain curves 

for each aggregate size studied.  Within the range of uniform aggregate sizes used, a 

small size effect is noticeable, where a larger aggregate size results in a stiffer response.  

This could be explained by the fact that the larger the aggregate size the fewer the 

resulting cracks in the specimen.  Fewer cracks yield less compression softening of the 

vertical compressive stress strain curves and resulting in stiffer responses.  Similar trend 

were obtained for the averaged values of the ultimate tensile strength (Figure 4-8), where 

the larger the aggregate size the stronger the specimen.  A change of size from 4.5 mm to 

12.0 mm increased the predicted strength by about 11%.  The small increasing of strength 

could be explained by the observed cracking behavior and the differences in the 

formation of major crack bands.  Smaller average aggregate sizes tend to yield more 

numerous crack planes in the specimen, such that the formation of a crack band can 

happen easier and sooner than for the case of the larger aggregate, where fewer crack 

planes are observed.  
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Figure 4-9 shows the variance of the residual error of the tensile stress strain curves 

plotted against the aggregate size.  This variance is a measure of the variability among the 

three tested samples referenced to the experimental data.  The variability of the test 

results is caused primarily by the initiation of distributed cracks and the formation of 

major crack bands.  Small aggregate size yields more distributed cracks that can form 

more crack patterns than the large aggregate sizes that yield fewer cracks.  However, the 

formation of a large crack has a more pronounced effect on a specimen than the 

formation of a smaller crack.   In this experiment, it was found that the use of aggregate 

sizes between 5.5 to 8 mm (or at 42 to 57% of passing) yielded the least variability 

(below 0.011 MPa2).  Therefore, the optimal aggregate size at 40 – 60% of passing of 

gradation (D40-D60) was recommended for reliable numerical simulations of the Nova 

Scotia coarse mix asphalt specimen. 
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Figure 4-7. Comparison of predicted and measured horizontal and vertical stress-strain 
curves for five aggregate sizes (4.5, 6.0, 8.0, 10.0 and 12.0 mm.), using 
Voronoi with internal fracture path tessellation: A) Horizontal stress-strain 
response at center of specimen and B) Vertical stress-strain response at center 
of specimen. 
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Figure 4-8. Ultimate tensile strength averaged from 3 samples for each aggregate size 
(4.5, 6.0, 8.0, 10.0 and 12.0 mm). 
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Figure 4-9. Variance of residual error of tensile stress strain curve for each aggregate size 
(4.5, 6.0, 8.0, 10.0 and 12.0 mm). 
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4.6 Sensitivity Analysis of Material Parameters Defined for Mastics 

4.6.1 Numerical Experiment 

This part of the study focused on the determination of the sensitivity of the 

parameters used to describe mastic strength.  Voronoi tessellations (without internal 

fracture paths) that have uniform particle size of 6.8 mm were used with parallel crack 

growth rule in this experiment.  First the numerical model was calibrated to match the 

stress strain curves of the Nova Scotia mixture to obtain material parameters for mastics.  

Then each of those calibrated parameters was altered to the higher and lower values and 

the resulting stress-strain response was observed.  In particular, for comparison purposes, 

the ultimate strength was monitored and used in the comparison.  The details of the 

numerical models and material parameters used for sensitivity analysis of the mastic are 

listed in Table 4-9 through Table 4-12. 

Table 4-9. Modeling matrix for the parametric study of mastic  
Component Description 
Tessellation Voronoi 

Crack growth rule Parallel 

Equivalent aggregate size (mm) 6.8 

Exterior boundary elements 152 

Potential crack elements for mastic 1408 

Potential crack elements for fracture path in aggregate 0 
 

Table 4-10. Global linear elasticity parameters for the parametric study of mastic 
Parameter Value 

Young modulus (MPa) 7500 

Poisson ratio 0.35 
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Table 4-11. Local material parameters (calibrated material parameters) for the parametric 
study of mastic 

Potential 
crack 
element 

To    
(MPa) 

DNCR    
(mm) 

Tsoft 
(MPa/mm)

Co      
(MPa) 

CR      
(MPa) 

Csoft 
(Mpa/mm) 

φo       
(degree) 

φR     
(degree)

Mastic 2.30 0.11 20.91 2.40 0.15 5.00 38 30 
 

Table 4-12. Varying parameters from the calibrated mastic shown in Table 4-11 for the 
parametric study of mastic 

To DNCR Tsoft Co CR Csoft φo φR 
(MPa) (mm) Linear Nonlinear (MPa) (MPa) (Mpa/mm) (degree) (degree)
1.90 0.03 76.67 1.00 2.00 0.000 1.00 32 24 
2.10 0.07 32.86  2.20 0.075 3.00 35 27 
2.30 0.11 20.91 1.00 2.40 0.150 5.00 38 30 
2.50 0.15 15.33  2.60 0.225 7.00 41 33 
2.70 0.19 12.11 1.00 2.80 0.300 9.00 44 36 

 

4.6.2 Numerical Results 

Figure 4-10 shows typical results of horizontal and vertical stress strain responses 

with variation in the cohesion (Co).  The subsequent Figures 4-11 through 4-18 show only 

the variation in ultimate tensile strength as the following parameters are varied:  cohesion 

(Co), tension cutoff (To), friction angle (φo), cohesion softening slope (Csoft), tension 

softening slope (Tsoft), opening crack limit (DNCR), residual cohesion (CR) and residual 

friction angle (φR).  It is noted that Tsoft and DNCR are redundant parameters.  In DIGS, 

two types of tension softening slope, linear (L) and nonlinear (N), can be selected.  The 

default linear model must set Tsoft equal to To/DNCR.  Without doing so, the nonlinear 

(power law) will be chosen in which the tensile strength decreases in a nonlinear fashion 

from the selected tension cutoff (To) to zero at a specified opening crack limit (DNCR).  

All these parameters are used to define Mohr Coulomb type of failure in Figure 3-2. 
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As expected, the ultimate tensile strength of specimen is strongly affected by the 

parameters controlling strength of failure envelope Co, To and φo as shown in Figure 4-11 

through 4-13).  It was noticeable from Figure 4-11 and 4-12 that cohesion was slightly 

more sensitive than the tension cutoff.  The parameters that control the rate of softening 

Csoft and Tsoft also affected the strength of specimen as can be seen in Figure 4-14 and  

4-15.  The opening crack limit (Figure 4-16) has an influence to the specimen strength in 

the same way as the tension softening slope.  The last two parameters CR and φR (Figure 

4-17 and 4-18) controlling residual strength of failure envelope were found to be less 

sensitive to the specimen strength.  

Figure 4-19 shows the results of stress strain curves predicted by two tension-

softening models, Linear and Nonlinear. There were not significantly different between 

these two, which may imply that the approximation of rate of tension softening were not 

critical for simulating the IDT strength test. 
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Figure 4-10. Change of stress-strain responses due to the varying of cohesion defined in 
mastic from 2.00 – 2.80 mm:  A) Horizontal stress-strain response at center of 
specimen and B) Vertical stress-strain response at center of specimen. 
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Figure 4-11. Sensitivity of the parameter cohesion defined in mastic to the ultimate 

tensile strength. 
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Figure 4-12. Sensitivity of the parameter tension cutoff defined in mastic to the ultimate 

tensile strength. 
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Figure 4-13. Sensitivity of the parameter friction angle defined in mastic to the ultimate 
tensile strength. 
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Figure 4-14. Sensitivity of the parameter cohesion softening slope defined in mastics to 
the ultimate tensile strength. 
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Figure 4-15. Sensitivity of the parameter tension softening slope (Linear Model) defined 

in mastic to the ultimate tensile strength. 
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Figure 4-16. Sensitivity of the parameter opening crack limit defined in mastic to the 
ultimate tensile strength 
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Figure 4-17. Sensitivity of the parameter residual cohesion defined in mastic to the 
ultimate tensile strength. 
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Figure 4-18. Sensitivity of the parameter residual friction angle defined in mastic to the 

ultimate tensile strength. 
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Figure 4-19.  A comparison of stress-strain response between using a Linear (default) and 
Nonlinear (still in experiment) tension - softening model for the range of 
opening crack limit DNCR 0.03 – 0.19 mm: A) Horizontal stress-strain 
response at center of specimen and B) Vertical stress-strain response at center 
of specimen. 

 



 61

4.7 Sensitivity Analysis of Material Parameters Defined for Internal Fracture Paths 

4.7.1 Numerical Experiment 

This part of the study focused on the identification of the sensitivity of the predicted 

ultimate tensile strength to the changes in material strength parameters defined for 

internal aggregate fracture paths.   In the experiment, the same Voronoi tessellation 

scheme, previously used, with a particle size of 6.8 mm was filled with internal fracture 

paths to simulate faults in the aggregates.  The same parallel crack growth rule was also 

used throughout, and the numerical model was first calibrated using the experimental 

stress- strain curves from the Nova Scotia mixture.  Material parameters for the mastic 

defined in Table 4-11 were kept the same from the previous study while calibrating 

material parameters for internal fracture paths of aggregate.  Then each of the internal 

fracture path strength parameter was changed to higher or lower values from the 

calibrated parameters to observe the sensitivity of the predicted stress-strain responses.  

All details of the models and material parameters used for the sensitivity analysis of the 

internal fracture paths are listed in Table 4-13 though Table 4-16. 

4.7.2 Numerical Results 

Figure 4-20 shows the effects of cohesion (Co) and tension cutoff (To) on the 

predicted ultimate strength.  It can be seen that an increase of cohesion and tension cutoff 

from 4.5 to 5.5 MPa increases the strength of the specimen.  Later increasing of both 

parameters to 8.5 MPa does not improve the strength.  Figure 4-21 shows the effect of the 

opening crack limit (DNCR) on the ultimate tensile strength.  Too small DNCR 0.01 mm 

cause brittle failure of specimen and higher DNCR 0.04, 0.07, 0.10, and 0.13 mm improves 

the strength. 
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Figures 4-22 through 4-25 show the effects of other parameters, friction angle (φo), 

cohesion-softening slope (Csoft), residual cohesion (CR), and residual friction angle (φR) 

on the ultimate tensile strength.  The ultimate tensile strength was found to be insensitive 

to these parameters. 

4.8 Summary of Sensitivity Analysis 

Numerical experiments of material parameters for the mastic and internal fracture 

paths revealed that the tensile strength of an IDT specimen was preliminary controlled by 

the mastic, which was the weakest link in specimen.  The tensile strength of specimen 

was most sensitive to the parameters controlling strength (cohesion Co, friction angle φo 

and tension cutoff To).  Parameters that control rate of softening (cohesion softening 

slope Csoft, tension softening slope Tsoft and opening crack limit DNCR) also affect the 

strength of specimen.  The residual parameters (residual cohesion CR and residual friction 

angle φR) have the least effects on the strength of.  Even though the last two residual 

parameters did not have a significant impact on strength, they do provide the smoothness 

for both ascending and descending curves of stress strain responses.   

When aggregate has internal fracture paths, the strength of the specimen is slightly 

weakened by the aggregate breakdown.  In studies, low aggregate toughness defined by 

cohesion and tension cutoff of 4.5 MPa (or 1.9 times that of mastic strength) decreased 

the specimen strength.  However, when aggregate is reasonable tough 6.0 to 8.5 MPa  

(or 2.5 to 3.5 times that of mastic strength), the toughness does not affect the strength of 

the specimen.  
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Table 4-13. Modeling matrix for the parametric study of internal fracture paths 
Component Description 

Tessellation Voronoi with internal fracture path

Crack growth rule Parallel 

Equivalent aggregate size (mm) 6.8 

Exterior boundary elements 152 

Potential crack elements for mastic 1408 

Potential crack elements for fracture path in aggregate 2717 
 

Table 4-14. Global linear elasticity parameters for the parametric study of internal 
fracture paths 

Parameter Value 

Young modulus (MPa) 7500 

Poisson ratio 0.35 
 

Table 4-15. Local material parameters (calibrated material parameters) for the parametric 
study of internal fracture paths 

Potential crack 
element 

To     
(MPa) 

DNCR  
(mm)

Tsoft 
(MPa/mm)

Co      
(MPa) 

CR    
(MPa)

Csoft 
(Mpa/mm) 

φo       
(degree)

φR     
(degree)

Mastic 2.30 0.11 20.91 2.40 0.15 5.00 38 30 
Internal fracture 
path 6.50 0.07 92.86 6.50 0.15 1.00 40 32 
 

Table 4-16. Varying parameters from the calibrated fracture path shown in Table 4-15 for 
the parametric study of internal fracture paths 

To 
(MPa) 

DNCR 
(mm) 

Co 
(MPa) 

CR 
(MPa) 

Csoft 
(Mpa/mm)

φo 
(degree)

φR 
(degree) 

4.50 0.01 4.50 0.000 0.10 35.0 27.0 
5.50 0.04 5.50 0.075 0.50 37.5 29.5 
6.50 0.07 6.50 0.150 1.00 40.0 32.0 
7.50 0.10 7.50 0.225 5.00 42.5 34.5 
8.50 0.13 8.50 0.300 10.00 45.0 37.0 
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Figure 4-20. Sensitivity of both parameters cohesion and tension cutoff defined in 
fracture path of aggregate to the ultimate tensile strength. 
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Figure 4-21. Sensitivity of opening crack limit defined in internal fracture path of 

aggregate to the ultimate tensile strength. 
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Figure 4-22. Sensitivity of friction angle defined in internal fracture path of aggregate to 
the ultimate tensile strength. 
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Figure 4-23. Sensitivity of cohesion softening slope defined in internal fracture path of 

aggregate to the ultimate tensile strength. 
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Figure 4-24. Sensitivity of residual cohesion defined in internal fracture path of aggregate 

to the ultimate tensile strength. 
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Figure 4-25. Sensitivity of residual friction angle defined in internal fracture path of 

aggregate to the ultimate tensile strength. 
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4.9 Recommendations for a Successful Numerical Simulation of IDT Strength Test 

This section summarizes and proposes a standard procedure for successfully model 

Superpave IDT strength test with the displacement discontinuity boundary element 

method. 

• Select “reasonable” IDT test results.  The IDT strength test that yields extremely 
high or low values of Poisson ratio (i.e. less than 0.1 or greater than 0.4) may show 
a sign of nonisotropic material behavior and should be disregarded.  

• Select “reasonable” load-deformation test results from the Superpave IDT test.   
A large discrepancy of stress strain curves obtained from each face of an IDT 
sample may reveal unsymmetrical aggregate structure in a specimen or highly 
nonhomogeneous behavior at the location of strain gauges  

Numerical analysis starts with creating an IDT numerical model using exterior 

boundary elements for the edge of specimen and filling the inside with potential crack 

elements, thus forming Voronoi tessellations or Voronoi tessellations with internal 

fracture paths.  With a suitable set of material parameters for the mastic and fracture 

paths in the aggregate, the predicted stress strain curves and crack patterns can match the 

experimental results.  The steps for numerical simulation of the IDT strength test can be 

summarized as follows: 

1. The first trial Young modulus (E) for numerical analysis can be approximated by a 

secant modulus at half ultimate strength ( )yx
x

Es νσσ
ε

−=
1 .  Subsequent trial 

values could be adjusted slightly higher or lower, such that it yields the best fit to 
the ascending portion of the vertical compressive and horizontal tensile stress strain 
curves. 

2. The Poison ratio can be obtained directly from IDT strength test.  Acceptable 
Poisson ratios for asphalt concrete should vary between 0.15 and 0.35.  Extreme 
values such as less than 0.1 or greater than 0.4 should not be used.   

3. Use Voronoi tessellation with parallel crack growth rule to calibrate material 
parameters for the mastic. 
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4. The particle size around D40 to D60 of gradation is recommended for consistent 
results. Using coarser aggregate size is also allowed to reduce computing time since 
the size effect is not very strong. 

5. Approximate material parameters for the mastic:  

a. For the first trail, cohesion (Co) and tension cutoff (To) can be set to the 
ultimate tensile strength of a given sample.  On subsequent trials, cohesion 
and tension cutoff may be adjusted slightly, according to the best fit to the 
vertical and horizontal stress strain curves. 

b. Friction angle (φo) around 38 to 40 degrees and opening crack limit (DNCR) 
between 0.10 to 0.12 mm have been found to be reasonable values for asphalt 
mixture. 

c. A linear tension softening model Tsoft must be defined equal to  
To /DNCR. 

d. Other parameters for mastics such as residual friction angle (φR), residual 
cohesion (CR) and cohesion-softening slope (Csoft) are chosen such that the 
predicted post peak responses fit the experimental post peak responses.  The 
suggested values for the first trial are φR 30 degree,  
CR = 0.10 MPa and Csoft  = 1.0 MPa/mm. 

6. Replace Voronoi tessellation with its dual Voronoi tessellation with internal 
fracture paths and calibrate material parameters for fracture paths within the 
aggregates. 

7. Material parameters for internal fracture paths within aggregates (in case the 
strength of the aggregate is not known, it is assumed that the aggregate is 
reasonable tough) 

a. Cohesion (Co) and tensile strength (To) can be set to any high values about 2.5 
to 3.5 times of those used for mastic strength. 

b. Friction angle (φo) of 40 degree and DNCR between 0.03 - 0.07 mm have been 
found to be good values for fracture paths inside aggregate. 

c. A linear tension softening slope Tsoft must be set to To/DNCR. 

d. Other parameters for internal fracture paths such as residual friction angle 
(φR), residual cohesion  (CR) and cohesion softening slope (Csoft) are chosen 
such that the predicted post peak responses fit to the experimental post peak 
responses.  The suggested values for the first trial are φR = 30 degree, CR = 
0.10 MPa and Csoft  = 1.0 MPa/mm. 

8. For known soft aggregates the exact values for the material parameters can be used. 
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9. Adjust material parameters until the predicted stress strain curves fit to the 
experimental stress strain curves for both the vertical and horizontal directions. 

4.10 Summary 

From the numerical studies conducted in this Chapter, it can be concluded that the 

appropriate tessellation scheme to represent the aggregate structure in the Superpave IDT 

strength test was a Voronoi tessellation scheme with internal fracture paths.  This 

tessellation scheme predicted the stress strain responses closest to the experimental 

results.  The internal fracture paths allowed the aggregates to break down at high loads, 

which realistically simulate the cracking behavior of IDT specimen observed in 

laboratory.  

The study to identify the appropriate crack growth rule for the indirect tension 

strength test resulted in the recommendation of using the parallel crack growth rule.  Both 

parallel and sequential methods predicted approximately the same stress strain responses 

and crack patterns, but the parallel consumed much less computing time than the 

sequential did.  Furthermore, it is highly possibly that several cracks in a specimen can 

occur simultaneously for fast loading test.  

The parametric studies of the aggregate size, material parameters for mastics, and 

material parameters for internal fracture path revealed that the primary factor that 

controlled the strength of IDT specimen were the strength of mastics.  The secondary 

factor was the strength of aggregate.  The least important factor was the aggregate size.  

Even though the aggregate size was not really important for the strength of specimen, 

from a calibration point of view, the larger the aggregate size the more difficult it is to 

tune the material parameters to fit the experimental results and the smaller the aggregate 

size, the longer the computing time.  For the gradations studied, it was found that an 
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optimal aggregate size around 40-60% passing of gradation (D40 - D60) yields the most 

consistent results with a reasonable amount of computational time.  

 



 

CHAPTER 5 
EVALUATION OF TENSILE STRENGTH AND FRACTURE ENERGY DENSITY  

5.1 Overview 

Tensile strength at fracture and fracture energy density have identified in previous 

studies (Sedwick, 1998 and Garcia, 2002) to be related to the fracture resistance of 

mixtures.  The Superpave tensile strength is referred to as the strength at the fracture 

point (Roque (1997) and Buttlar et al.,(1997)).  The strength at this point is normally 

slightly lower than the tensile strength at ultimate load.  Another parameter, the fracture 

energy density at the center of the IDT specimen, has also been used to evaluate the 

cracking resistance of mixtures.  The fracture energy can be obtained by integrating the 

area under tensile stress-strain curve up to the point of fracture. 

During Superpave IDT strength test, load is recorded as well as vertical and 

horizontal deformations at strain gauges.  To account for three-dimensional effects, 

bulging correction factors Cbh and Cbv shown in Table 5-1 are applied to correct the 

measured horizontal and vertical deformations to the deformations in flat planes  

bhmeasuredcorrected CHH =         (5-1) 

bvmeasuredcorrected CVV =         (5-2) 
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Table 5-1. Correction factors accounting for bulging effect 
Poisson's ratio Diameter - to - Thickness ratio (t/D) D = 4" or 6" 

 ν 0.167 0.333 0.500 0.625 0.750 
0.20 0.9816 0.9638 0.9461 0.9358 0.9294 
0.35 0.9751 0.9518 0.9299 0.9179 0.9108 CBX 
0.45 0.9722 0.9466 0.9234 0.9111 0.9040 
0.20 0.9886 0.9748 0.9677 0.9674 0.9688 
0.35 0.9808 0.9588 0.9479 0.9473 0.9493 CBY 
0.45 0.9759 0.9492 0.9361 0.9358 0.9380 

 

The corrected horizontal and vertical deformations are then divided by the gauge 

length GL to obtain the average strains, and again the strain center correction factors  

Ceh = 1.072 and Cev  = 0.977 are applied to change the average strains to the strains at the 

center of specimen  

eh
corrected

correctedh C
GL

H
=_ε        (5-3) 

ev
corrected

correctedv C
GL

V
=_ε         (5-4) 

In the same way as strains, the corresponding stresses in the horizontal and vertical 

directions evaluated at center of specimen can be computed by two-dimensional plane 

stress formulas and are then corrected with the center stress correction factors Cσh and Cσv 

shown in Table 5-2 to convert these stresses in a plane to the stresses on the surfaces of 

3D specimen 

hcorrectedh C
DT
P

σπ
σ 2

_ =         (5-5) 

vcorrectedv C
DT
P

σπ
σ 6

_ =         (5-6) 

Fracture point in specimen can be detected by monitoring the deformation 

differential (Vcorrected - Hcorrected) recorded at each load step and marking the point when it 
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starts to deviate from the smooth curve.  Corresponding to the fracture point, the recorded 

applied load and the measured horizontal and vertical deformations are used to calculate 

the tensile strength and fracture energy density as previously described. 

Table 5-2. Correction factors accounting for stress at center of specimen 
D = 4”or 6” Poisson’s ratio Diameter – to – Thickness ratio (t/D) 

 ν 0.167 0.333 0.500 0.625 0.750 
0.20 0.9471 0.9773 1.0251 1.0696 1.1040 
0.35 0.9561 1.0007 1.0871 1.1682 1.2321 

CσxCTR 
 
 0.45 0.9597 1.0087 1.1213 1.2307 1.3171 

0.20 -0.9648 -0.9754 -0.9743 -0.9693 -0.9611 
0.35 -0.9732 -0.9888 -0.9844 -0.9710 -0.9538 

CσyCTR 
 
 0.45 -0.9788 -0.9971 -0.9864 -0.9646 -0.9395 
 

5.2 Numerical Model V.S. Asphalt Mixtures 

The displacement discontinuity boundary element method assumes the material to 

be linear elastic until fracture. When cracks appear in the specimen, the linear elastic 

behavior still remains but with a plastic failure and localization in the crack.   

For this part of the study, three mixtures, Nova Scotia, NW39_1C and 

I95SJN_BWP described in Table 5-3 were chosen.  These mixtures range from having a 

predominantly ductile failure mode (Nova Scotia mix) to a very brittle failure mode 

(I95SJN_BWP) to evaluate the capabilities of the displacement discontinuity method of 

simulating very different mixture responses.  The material properties obtained from IDT 

strength tests of three mixtures are listed in Table 5-4. 

In this study, a single “representative” sample was selected out of the three samples 

tested for each mixture, based on the closeness of the measured load-deformation 

responses at both sides of the sample.  In the case of the Nova Scotia and NW39_1C 

mixtures, the middle sample was selected, but for the I95SJN_BWP the upper bound 

sample was selected.  Once a “representative” sample for each mix was selected, the 
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measured load and deformations were used to calculate vertical and horizontal stress-

strain curves on the faces of the specimen as described in the previous section.  Then the 

averaged stress strain-curves from both faces were used for comparisons to the numerical 

simulation. 

Table 5-3. Gradation of three mixtures used in simulations 
Sieve size Percent passing 
 Nova Scotia NW39_1C I95SJN_BWP
25 mm (1) 100   
19 mm (3/4) 97 100 100 
12.5 mm (1/2) 83 93 91 
9.5 mm (3/8) 66 87 76 
4.75 mm (#4) 38 62 53 
2.36 mm (#8) 23 46 40 
1.18 mm (#16) 18 39 36 
600 µm (#30) 14 33 34 
300 µm (#50) 10 27 28 
150 µm (#100) 6.5 14 19 
75 µm (#200) 3.5 8 5 
(1) Nova Scotia was a virgin coarse-graded mix with 19 mm nominal maximum 
aggregate size, designed according to SuperPaveTM specifications. The mixture has 7.0% 
air void and 5.5% design asphalt content with an asphalt binder of grade AC30. 
 
(2) NW39-1C was a core excavated on Section 1 (cracked pavement), from Alachua 
County, FL, on NW39th Ave., eastbound, section limit 34th St – 24th St.  The  pavement 
was 14 years old at the time of coring. The mixture was a fine-graded mix with 12.5 mm 
nominal maximum aggregate size, 7.3% air void, 4.7% effective asphalt content (the 
recovered unknown binder has Brookfield viscosity 16000 Poises at 60 oC). 
 
(3) I95SJN_BWP was a core excavated between wheel paths, from St. Johns County on 
Interstate I95, northbound, county milepost limit 26.218-34.855.  The age of the 
pavement was 5 years old. The mixture was a fine-graded mix with 12.5 mm nominal 
maximum aggregate size, 4.0% air voids, 4.7% effective asphalt content  (AC30 was 
believed to be used with the recovery Brookfield viscosity 36548 Poises at 60 oC). 
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Table 5-4. Material properties of three mixtures obtained from Superpave IDT tests 
Mixtures Test 

temp. 
 

(oC) 

Failure 
strain 
(micro 
strain) 

Tensile 
strength

 
 (MPa)

Fracture 
energy 
density
(KJ/m3)

Poisson 
ratio 

D0 
 
 

(1/GPa) 

D1 
 

(1/Gpa*
sec) 

m 

Nova Scotia 0 618 2.05 0.83 0.35 0.0645 0.0271 0.567 
NW39_1C 10 786 2.70 1.38 0.30 0.0521 0.0192 0.524 
I95SJN_BWP -10 590 3.19 1.44 0.22 0.0936 0.0014 0.574 
 

5.3 Numerical Simulation of Three Mixtures 

Modeling matrix of the displacement discontinuity models for simulating three 

mixtures, Nova Scotia, NW39_1C and I95SJN_BWP are shown in Table 5-5.  Based on 

the size effect study of Voronoi particles in Chapter 4, Voronoi particles with average 

diameters of 8.1 mm were used for the Nova Scotia coarse mix, and slightly smaller 

particles 6.8 mm for NW39_1C fine mix and 6.6 mm for I95SJN_BWP fine-graded mix.  

The numbers of exterior boundary elements for constructing the edge of three specimens 

were 152, of those, 8 elements each were used for simulating fix condition at the bottom 

and displacement control at the top.  The displacement control for all three mixtures was 

divided into 20 equal load steps for the total vertical displacement of 0.35, 0.30 and 0.19 

respectively. The number for potential crack elements, simulating mastics and internal 

fracture paths inside Voronoi particles are provided in Table 5-5. 

Table 5-6 shows global material parameters (Young modulus and Poisson ratio) for 

numerical models simulating three mixtures.  Poisson ratios were obtained directly from 

IDT strength test. The secant modulus at 50 percent of the ultimate load was found to be 

a good value for the Young modulus in the numerical model.   Other local material 

parameters for mastics and internal fracture paths for the three numerical models in  

Table 5-7 were determined by numerical tuning. 
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From the sensitivity analysis presented in Chapter 4, it was found that cohesion Co 

and tension cutoff To of the mastic control the tensile strength of the specimen. Therefore, 

by tuning these two parameters, the predicted ultimate load in the stress-strain curves can 

fit to the ultimate load of given stress-strain curves.  The residual strength of the mastic 

was also used to provide additional strength when the material damages.  They provided 

the fit to the stress-strain responses in the post peak region of the stress-strain curves.  

Other local parameters for the mastic and fracture path in the aggregates are less 

important; they can be used to adjust the predicted stress strain curves to have the best fit 

of given stress-strain curves.  The complete calibrated local material parameters that 

make numerical models fit to the test results are listed in Table 5-7.  Once the numerical 

models fit the test results, the tensile strength at fracture and fracture energy density were 

evaluated according to SHRP method described earlier. 

Table 5-5. Modeling matrix for three mixtures used:  
Mixtures 

 
 
 
 

Specimen 
size 

(diameter x 
thickness) 

 
 

(mm x mm) 

Equivalent 
Voronoi 
diameter 

 
 
 

(mm) 

Number 
of exterior 
boundary 
elements

 

Number 
of 

potential 
crack 

elements 
for mastic

Number of 
potential 

crack 
elements for 

internal 
fracture 
paths 

Total 
vertical 

deformation 
at load plate 
for 20 load 

step        
(mm) 

Nova Scotia 150.0 x 50.3 8.1 152 978 1,791 0.350 
NW39_1C 150.6 x 28.2 6.8 152 1,409 2,651 0.325 
I95SJN_BWP 143.5 x 53.6 6.6 152 1,249 2,287 0.190 
 

Table 5-6. Global linear elasticity parameters for three mixtures used 
Mixtures      
 

Young modulus 
(MPa) 

Poisson ratio 
 

Nova Scotia 7,250 0.35 
NW39_1C 8,500 0.30 
I95SJN_BWP 13,250 0.22 
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Table 5-7. Local material parameters for three mixtures used 
Mixtures 
 

Potential 
crack 

elements 

To    
 

(MPa)

DNCR  
 

(mm)

Tsoft 
(MPa/
mm) 

Co    
 

(MPa)

CR    
 

(MPa)

Csoft 
(Mpa/
mm) 

φo       
 

(degree)

φR     
 

(degree)
Mastic 2.30 0.10 1.0 2.50 0.15 1.0 38 30 

Nova Scotia 
 

Internal 
fracture 

path 6.25 0.05 1.0 6.25 0.10 1.0 40 30 
Mastic 3.05 0.07 1.0 3.20 0.10 1.0 35 20 

NW39_1C 
 

Internal 
fracture 

path 8.00 0.05 1.0 8.00 0.10 1.0 40 30 
Mastic 4.50 0.03 1.0 4.90 0.10 1.0 35 20 

I95SJN_BWP 
 

Internal 
fracture 

path 9.00 0.03 1.0 9.00 0.10 1.0 40 30 
 

5.4 Numerical Test Results 

The predicted stress strain curves of three mixtures (Figure 5-1) agreed well with 

the experimental results.  The predictions matched both horizontal tensile and vertical 

compressive stress strain curves up to the peak and they partially captured the post peak 

responses. 

Figure 5-2 shows the deformation differential of three mixtures: Nova Scotia, 

NW39_1C and I95SJN_BWP.  The fracture points marked in Figure 5-1A were 

determined at the peaks of the curves where the deformation differentials start to drop.   

The corresponding tensile strength at fracture point is shown in Figure 5-3.   

The differences between the predicted values and the average values for Nova Scotia, 

NW39_1C and I95SJN_BWP were 5.3%. 5.6% and 12.5% respectively.  Figure 5-4 

compares the predicted fracture energy densities to the trim mean average values of the 

mixes (Table 5-4).  The trim mean average value of a given mix was calculated by 

excluding the highest and the lowest of the reported values on 6 faces of the 3 samples 

and average the remaining four.  The differences between the predicted values and the 
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trim mean average values for Nova Scotia, NW39_1C and I95SJN_BWP were -3.6%, 

0.7% and –31.2% respectively.   

The large discrepancy of the I95SJN_BWP was likely primary due to the variability 

in the experimental test results. The test result of mix I95SJN_BWP samples  

1 to 3 had tensile strengths of 3.75, 3.38 and 2.45 MPa respectively and fracture energy 

densities reported on each face of sample 1 to 3 were (1.56, 1.68),  (0.70, 1.33), and 

(1.20, 2.38) KJ/m3 respectively.   Overall, the method yields a good approximation for 

tensile strength at fracture and fracture energy density when the material variability is 

small and becomes less reliable when the variability is high. 

Figure 5-5 shows crack patterns of three mixtures at three critical load steps:  

A) crack initiation, B) crack at fracture points and C) major opening cracks at final load 

step.  All three samples have the same crack pattern that several micro cracks randomly 

initiate in the tension zone and coalesce to form a major opening crack, which can be 

observed in laboratory. 
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Figure 5-1. Comparison of predicted and measured horizontal and vertical stress-strain 
curves for three mixtures: Nova Scotia, NW39_1C and I95SJN_BWP.  
A) Horizontal stress strain responses at center of specimen and B) Vertical 
stress strain responses at center of specimen. 
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Figure 5-2. Simulated deformation differentials for the Nova Scotia, NW39_1C and 
I95SJN_BWP mixtures. 

2.05

2.70

3.19

2.16

3.59

2.85

0.0

1.0

2.0

3.0

4.0

Nova Scotia NW39_1C I95SJN_BWP

Te
ns

ile
 S

tr
en

gt
h 

(M
Pa

)

Average

 

DDM

 
Figure 5-3. Tensile strength at fracture for three mixtures (Nova Scotia, NW39_1C and 

I95SJN_BWP). The average value of each mixture was compared to the 
tensile strength predicted by displacement discontinuity method (DDM). 
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Figure 5-4. Fracture energy density at center of specimen for three mixtures (Nova 

Scotia, NW39_1C and I95SJN_BWP).  The trim mean average value of each 
mixture was compared to the fracture energy density predicted by 
displacement discontinuity method (DDM).  
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Figure 5-5. Predicted crack patterns for the three mixtures (Nova Scotia, NW39_1C and 
I95SJN_BWP) at three load steps: A) Crack initiation in specimen (first 
cracks that appear in specimen), B) Crack pattern at fracture point and  
C) Cracks at the final load step. 
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5.5 Conclusions 

Explicit fracture modeling with the displacement discontinuity boundary element 

method successfully simulated the cracking behavior of three asphalt mixtures and 

evaluated their tensile strength and fracture energy density.  It can be concluded, 

according to three mixtures demonstrated here, that the explicit fracture model with 

displacement discontinuity elements has the potential to simulate the cracking behavior 

and reasonably evaluate tensile strength and fracture energy density. 

 



 

CHAPTER 6 
SUMMARY, CONCLUSIONS AND RECOMMENDATIONS  

6.1 Summary 

Several studies using the displacement discontinuity boundary element method 

were conducted to identify the most appropriate set of components for a numerical model 

that can realistically simulate the Superpave IDT strength test.  Parametric studies were 

also performed to identify the key factors that control the cracking behavior of asphalt 

mixtures.  Finally, the method was applied to evaluate the fracture behavior of mixtures.  

A summary of the findings obtained from each study is listed below: 

• The most suitable tessellation scheme to represent aggregate structure was the 
Voronoi with internal fracture paths.  Voronoi tessellations alone can also yield a 
reasonable results but it was found difficult to calibrate material parameters to fit 
the experimental stress strain curves, especially at the peak and in the post-peak 
part of the stress-strain curves.  Deluanay tessellation schemes were found 
unsuitable to represent aggregate structure because the resulting cracked structure 
causes floating regions, which sometimes lead to instability at strain gauge 
locations. 

• The mastic properties are key to controlling the cracking behavior of asphalt 
mixtures.  At the beginning, the initiation and propagation of microcracks in the 
mastic weakens the aggregate structure and causes compression softening in the 
stress-strain curve.  As the number of active cracks and their sizes increase, the 
sample stiffness decreases rapidly. The strength is terminated when the random 
major cracks appear in the mastic.  The material parameters defined for the mastic 
that are directly related to the strength of the specimen are cohesion, tension cutoff 
and friction angle.  The rate of cohesion softening, tension softening and opening 
crack limit also affected the strength of specimen.  The residual cohesion and 
residual friction angle had little effect to the strength of specimen, but they do 
control the post peak behavior of stress strain responses. 

• Toughness of rock represented by the strength of the fracture paths inside 
aggregates is not sensitive to the specimen strength as long as it is about 2-3 times 
larger than the mastic strength.  The break down of aggregate at high load levels 
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yields a smooth compression softening curve near the peak of the vertical 
compression stress strain curve. 

• In the numerical experiments, using different uniform aggregate size revealed a 
small size effect on the strength of specimen.  Smaller aggregate sizes yield more 
distributed cracks and cause softer responses than the larger aggregate sizes.   

• The current version of DIGS that uses Mohr-Coulomb type of failure can simulate 
the Superpave IDT strength test and evaluate its mixture properties with acceptable 
accuracy. 

6.2 Conclusions 

Based on the finding previously discussed, the following conclusion were made: 

• The displacement discontinuity boundary element method with tessellation scheme 
can simulate the Superpave IDT strength test. 

• Voronoi tessellation with internal fracture paths is the best representative of 
aggregate structure. 

• The parallel crack growth rule is suitable for simulating the Superpave IDT 
strength test because it is more economical than the sequential crack growth rule. 

• The factors that control the strength of a Superpave IDT specimen ranked from the 
most to the least are strength of mastic, strength of fracture path in aggregates, and 
aggregate size. 

6.3 Recommendations 

Based on the findings and conclusions of numerical experiments the following 

recommendations are made: 

• From the numerical studies, the mastic, which is the weakest link in the specimen, 
plays the most important role in cracking behavior in the Superpave IDT test.  The 
mastic in a numerical model refers to the apparent strength of the mastic in the 
presence of air voids.  The improvement of mastic properties will directly result in 
the increase of cracking resistance. 

• Despite the success of the numerical modeling, the simulations were merely the 
results of the assumptions made in the models.  Whether the assumptions are 
reasonable may require the development of testing procedures to more directly 
obtain values for the micromechanical parameters used. 

• Other failure laws that can simulate viscoplastic and cyclic loading should be 
developed so that the method will yield more useful applications. 
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• The incorporation of multi-region boundary element codes into DIGS that can 
simulate layered pavement is recommend for future research.  These will provide 
analytical tools to simulate and observe cracking behavior of specific mixtures in a 
pavement. 

 



 

APPENDIX 
USER MANUALS FOR PRE/POST PROCESSOR (DDM) 

A.1 Introduction 

This user manual explains how to use PRE/POST processor DDM with the program 

Discontinuity Interaction and Growth Simulation DIGS and Delaunay Voronoi 

Tessellation Generator DVT.  DDM is a graphic user interface operates under window 

environment.  It can read and write codes to the files associated with DIGS and DVT.  

Three file types (*.IN, ._SG and .DAT) are involved with PRE processor and other three 

file types (*.OUT, *.REQ and *.RPT) are involved with POST processor.   DIGS is a 

two-dimensional (plane strain) stress analysis computer code that can be used to solve 

crack, fault and tabular stope interaction and intersection problems.  The code is based on 

the displacement discontinuity boundary element method and employs linear-variation 

shape functions in the element.  DVT is a mesh generator for Delaunay and Voronoi 

tessellation. The result of meshing can be used to simulate granular structure of the 

desired material. 

Input file (*.IN) contains information of meshing parameters and boundary 

definition of the regions to be meshed.  The IN file is used with the DVT to generate two 

segment files (*._SG): Delaunay (*.DSG) and Voronoi with internal fracture path 

(*.VSG).  Segment file contains definitions of ‘Line’ segments that describe geometry of 

the problem to be solved.  User can use PRE processor to open these two segment files, 

edit segment definitions and save them to other segment file names (*._SG) for later 

used.  It is required by the PRE processor that the segment file must have its last two 
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letters ‘SG’ in the extension.  Data file (*.DAT) contains essential information 

(background material properties, primitive stress fields, boundary conditions, load step, 

segment file name and request output report) to run boundary element analysis with 

DIGS.  Even though, segment definitions can be explicitly defined within the DAT file, 

the PRE processor does not recognize that format.  Users must complexly define the 

geometry of the problem in a segment file and attach its name to the DAT file.  Output 

file (*.OUT) contains the results from boundary element analysis.  POST processor can 

open this file to view the result graphically. Users can also request specific output 

variables at desired load steps by writing command codes in the request file (*.REQ) and 

reporting them to the report file (*.RPT). 

A.2 Coordinate Systems 

The DIGS code assumes that all discontinuity positions are defined with respect to a 

global Y-Z coordinate system as depicted in Figure A-1. The X-axis is assumed to point 

into the plane of the diagram and all displacements in the X-direction are assumed to be 

zero (i.e. plane strain with respect to the Y-Z plane). 
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Figure A-1. Global (Y-Z) and local (y-z) coordinate systems used by DIGS. 
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Each defined element is flat and has a local y-z coordinate system as shown in  

Figure A-1.  The ends of the element are marked “o” and discontinuity values are 

computed at two collocation points (c1 and c2) within the element, marked “x”.  The local 

element axis system implies an orientation of the element with the positive (+) side in the 

positive z direction and the negative (-) side in the opposite direction.  No continuity 

conditions on the discontinuity slip or opening values are enforced between adjoining 

elements.  It is important that elements should not be defined to intersect one another but 

may be defined to be connected at their end points. 

A.3 Text Files Associated with PRE/POST Processor 

There are total 6 files (*.IN, *._SG, *.DAT, *.OUT, *.REQ and *.RPT) associated 

with PRE/POST Processor. The following 6 subsections will explain the structure and 

command codes used in each file. 

A.3.1 Input File (*.IN File) 

The IN file is an input text file containing computer codes for the program DVT to 

generate two tessellations: Delaunay and Voronoi with internal fracture path.  The 

computer codes are written in fixed field format. That mean users have to write the codes 

within a specific range of columns.  The structure of IN file consists of 3 coding blocks as 

following.  

• Random point generation 
• Seed triangle for creating tessellation 

-End of region definition (‘R/’) 
• Boundary definitions 

-End of boundary line definition (‘B/’) 
-Comments (optional) 
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To explain the code for each field, the Fortran format ‘An’ is used for characters, 

‘In’ for integer values, ‘Fn’ for floating point numeric values where n denotes the length 

of the record field. 

Random Point Generation (defined in one line) 

Field 1 (A3):  Random point generation code = ‘RMG’ 

Field 2 (I8):   Nominal number of points to be generated.  Suppose there is an area A to 

be generate with the nominal mesh length g.  The nominal number of point 

is N = A/g2.  However, it should set the number of point to be slightly 

greater than N, say 1.5*N. 

Field 3 (I8): Random number seed.  It is an arbitrary number used as a start sequence in 

the FORTRAN random number routine. 

Field 3 (I8): Minimum point spacing constraint.  When the random points are 

generated, they are never allowed to be closer to one another than this 

minimum distance. This prevents coincident points or very closely spaced 

points leading to very irregular mesh triangle generation. 

Field 4 (F8): Start y-coordinate of a rectangular area (Left) for random point to be 

generated. 

Field 5 (F8): Start z-coordinate of a rectangular area (Top) for random point to be 

generated. 

Field 6 (F8): End y-coordinate of a rectangular area (Right) for random point to be 

generated. 

Field 7 (F8): End z-coordinate of a rectangular area (Bottom) for random point to be 

generated. 
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Field 8 (F8): Subtended angle for Voronoi edge condensation.  In the Voronoi polygon 

generation, each random point forms the so-called geometric center of the 

polygon. Joining a set of lines from the center to each vertex of the 

polygon, defines a set of triangles with a common vertex at the center.  If 

the angle formed between the sides of any triangle emanating from the 

central vertex is less than the specified tolerance, then the other two points 

of the triangle are condensed to one point. This effectively eliminates very 

short mesh lengths in the Voronoi construction (but of course destroys the 

Voronoi diagram strict properties). 

Seed Triangle for Construction of Tessellation (defined in one line) 

Field 1 (A1):  Seed triangle code = ‘S’ 

Field 2 (I8):   Seed triangle vertex component y1 

Field 3 (I8):   Seed triangle vertex component z1 

Field 4 (I8):   Seed triangle vertex component y2 

Field 5 (I8):   Seed triangle vertex component z2 

Field 6 (I8):   Seed triangle vertex component y3 

Field 6 (I8):   Seed triangle vertex component z3.  

The triangle will be used as a starter to form Delaunay tessellation and 

construct its dual mesh Voronoi. It is important to place the triangle in the 

region where tessellation to be generated. 

End of Region Definition (defined in one line) 

Field 1 (A2):   End of region definition = ‘R/’ 

Boundary Definition (defined as many lines as needed) 

Field 1 (A3):   Boundary definition code = ‘BLB’ or ‘BCB’ 
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BLB : B = ‘boundary’ definition; L = ‘line’ type; B = ‘color’ code stored 

in output record. 

BCB : B = ‘boundary’ definition; C = ‘circle’ type; B = ‘color’ code 

stored in output record. 

DDM recognizes only two boundary definition codes ‘BLB’ and ‘BCB’. 

The color code ‘B’ is not used in the PRE/POST processor but must be 

defined as part of the boundary definition code. 

Field 2 (I8):   Number of elements along the boundary line.   

Field 3 (F8):   Minimum distance a random point is allowed from the boundary.  Too 

small distance may result in generated mesh crossing the boundary line.  

Field 4 (F8):   Start y-coordinate of the line (for boundary definition code ‘BLB’) or  

Start y- coordinate of the center (for boundary definition code ‘BCB’) 

Field 5 (F8):   Start z-coordinate of the line (for boundary definition code ‘BLB’) or  

Start z-coordinate of the center (for boundary definition code ‘BCB’) 

Field 6 (F8):   End y-coordinate of the line (for boundary definition code ‘BLB’) or  

End y-coordinate on the circumference (for boundary definition code 

‘BCB’) 

Field 7 (F8):   End z-coordinate of the line (for boundary definition code ‘BLB’) or  

End z-coordinate on the circumferences (for boundary definition code 

‘BCB’) 

End of Boundary Line Definition (defined in one line) 

Field 1 (A2):   End of boundary line definition = ‘B/’ 
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Comment Record (defined as many lines as needed) 

Any record starting with the characters ‘**’ is ignored and treated as a comment.  

In the IN file, comments can only be placed after the end of boundary line definition 

(‘B/’).  Placing comments among the lines of codes will cause errors. 

Example 1:  Square Plate with a Circular Hole (PLATE_H.IN) 

Figure A-2 shows a square plate that has a size of 100x100 mm. The boundary 

region consists of four ‘Line’ segments and a ‘Circular’ segment.  ‘Linear’ and ‘Circular’ 

segments are each divided into 10 elements.  Points used for constructing of tessellation 

are randomly seeded from the ‘Left Top’ corner (-50, -50) to the ‘Right Bottom’ corner 

(50, 50) of the model with these parameters: nominal number of points = 1000, random 

number seed = 1, minimum point spacing constraint = 10, subtended angle for Voronoi 

edge condensation = 15.  An initial triangle with the coordinates (30,0), (40,0) and (35, 

10) are placed between the inner circle and the outer square.  The mesh generation is not 

allowed to go closer than 5 mm to the ‘Line’ segment and 10 mm to the ‘Circular’ 

segment. 

 
 
Figure A-2.  Square plate with a circular hole for the input file. 
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The following codes in PLATE_H.IN can be used with DVT.exe to generate 

Delaunay tessellation and Voronoi tessellation with internal fracture path. 

PLATE_H.IN 

RMG    1000       1      10     -50     -50      50      50      15 

S        30       0      40       0      35      10 

R/ 

BLB      10       5     -50     -50      50     -50 

BLB      10       5      50     -50      50      50 

BLB      10       5      50      50     -50      50 

BLB      10       5     -50      50     -50     -50 

BCB      10      10       0       0       0      15 

B/ 

***  

*** use DVT.exe to generate tessellation 

 
A.3.2 Segment File (*._SG) 

The segment file is a text file containing definition of segments that describe 

geometry of the problem.  The DVT uses the IN file to generate two segment files named 

Dealuanay tessellation file (*.DSG) and Voronoi with internal fracture path tessellation 

file (*.VSG).  The computer codes of these two files are written in fixed field format. The 

structure of the segment file consists of several lines of segment definitions, which its 

codes are as follows. 

Segment Definition (defined as many lines as needed) 

Field 1 (A1):  Segment type code 

= ‘S’ for ordinary boundary segment  

= ‘?’ for potential crack segment 
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Field 2 (A1):   A letter code refers to boundary condition code for ordinary boundary 

segment or material constitutive code for potential crack segment. 

Field 3 (I4):   Segment number 

Field 4 (I4):   Number of elements per segment  

Field 5 (F8):   Start y-coordinate for a line segment 

Field 6 (F8):   Start z-coordinate for a line segment 

Field 7 (F8):   End y-coordinate for a line segment 

Field 8 (F8):   End z-coordinate for a line segment 

Field 9:   The remaining codes are not used by the program. 

 
Example 2:  Square Plate with a Circular Hole (PLATE_H.DSG and PLATE_H.VSG) 

Figure A-3 below shows the result of using DVT with PLATE_H.IN to generate 

Delaunay and Voronoi with internal fracture path tessellations. The segment files 

PLATE_H.DSG and PLATE_H.VSG can be included in a DAT file to describe the plate 

geometry and tessellation used in a problem. 

 
A    B 

 
Figure A-3. Square plate with a circular hole for the segment files:  

A) Delaunay tessellation (PLATE_H.DSG) and B) Voronoi with internal with 
fracture path (PLATE_H.VSG). 
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Here are the samples of codes written in the segment files (PLATE_H.DSG and 

PLATE_H).  The segment files can then be attached to the DAT file to run the boundary 

element analysis with DIGS. 

PLATE_H.DSG 

SM   1   1  30.000    .000  40.000    .000     0.0     0.0           G   T T 

SM   2   1  40.000    .000  35.000  10.000     0.0     0.0           G   T T 

SM   3   1  35.000  10.000  30.000    .000     0.0     0.0           G   T T 

SB   4   1 -50.000 -50.000 -40.000 -50.000     0.0     0.0           B   T T 

SB   5   1 -40.000 -50.000 -30.000 -50.000     0.0     0.0           B   T T 

SB   6   1 -30.000 -50.000 -20.000 -50.000     0.0     0.0           B   T T 

. 

. 

. 

SM 248   1 -50.000 -10.000 -44.795  -8.764     0.0     0.0           G   T T 

SM 249   1 -50.000 -30.000 -42.834 -30.814     0.0     0.0           G   T T 

SM 250   1 -50.000 -50.000 -40.659 -43.330     0.0     0.0           G   T T 

 

PLATE_H.VSG 

SV   1   1 -50.000 -50.000 -45.000 -50.000     0.0     0.0           W   T T 

SV   2   1 -45.000 -50.000 -40.000 -50.000     0.0     0.0           W   T T 

SV   3   1 -40.000 -50.000 -35.000 -50.000     0.0     0.0           W   T T 

. 

. 

. 

?V 711   1  33.368  20.420  24.491  22.315     0.0     0.0           W   T T 

?V 712   1  33.368  20.420  34.769  27.095     0.0     0.0           W   T T 

?V 713   1  33.368  20.420  39.906  23.158     0.0     0.0           W   T T 
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A.3.3 Data File (*.DAT)  

The DAT file is a text file that contains command codes describing background 

material, primitive stress fields, boundary conditions, material constitutive models, load 

steps and output reports.  The codes are written in fixed field format.  The structure of the 

DAT file consists of 4 coding blocks.  

• General parameters for background material and primitive stress fields 
• Boundary conditions 
• Material constitutive models for potential crack segments 
• Processing steps (or load step) 

o Processing step element report requests 
o Processing step field point report requests 

 - Comments (optional) can be placed at any locations between each coding bock. 
 - End of Data file marked with ‘//’ 

 
General Parameters for Background Material and Primitive Stress Fields  
(defined in one line) 

Field  1 (A1): Record type character = ‘P’ 

Field  2 (A1): Symmetry control character 

  = ‘R’ – No symmetry, infinite region 

= ’H’ – Half-space problem in region , enforcing a stress-free surface 

on  

0≥z

0=z

  = ‘Y’ – Symmetry with respect to the y-axis ( 0=z ) 

  = ‘Z’ – Symmetry with respect to the z-axis ( 0=y ) 

  = ‘D’ – Double symmetry with respect to both the y-axis and the z-axis 

  = ‘A’ – Anti-symmetry through the origin 0=y , 0=z  

Field  3 (F8): Young’s modulus (MPa) 

Field  4 (F8): Poisson’s ratio 
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Field  5 (F8): Stress gradient, with respect to the z – direction, of the yy stress 

component of the primitive stress field (MPa / m) 

Field  6 (F8): Stress gradient, with respect to the z – direction, of the zz stress component 

of the primitive stress field (MPa / m) 

Field  7 (F8): Constant yy component of the primitive stress field 

Field  8 (F8): Constant yz component of the primitive stress field 

Field  9 (F8): Constant zz component of the primitive stress field 

Boundary Conditions (defined as many lines as needed) 

Field  1 (A1): Record type character = ‘C’ 

Field  2 (A1): Single character for boundary condition code. 

Field  3 (A1): Format selection character for explicit boundary condition interpretation 

(Set character = ‘C’) 

Field  4 (A1): Shear boundary condition indicator; set character = ‘S’ 

Field  5 (A1): Shear boundary condition type selection code: 

  = ‘T’ – local shear traction component specification  

  = ‘D’ – local shear discontinuity component specification  

= ‘+’ – local y displacement component specification on ‘+’ side of 

element 

  = ‘-’ – local y displacement component specification on ‘-’ side of element 

Field  6 (F10): Numerical value of selected shear boundary condition at collocation  

point 1 

Field  7 (F10): Numerical value of selected shear boundary condition at collocation  

point 2 

Field  8 (A1): Normal boundary condition indicator; set character = ‘N’ 
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Field  9 (A1): Normal boundary condition type selection code: 

  = ‘T’ – local normal traction component specification  

  = ‘D’ – local normal discontinuity component specification  

= ‘+’ – local z displacement component specification on the ‘+’ side of 

element 

= ‘-’ – local z displacement component specification on the ‘-’ side of 

element 

Field 10 (F10): Numerical value of selected normal boundary condition at collocation 

   point 1 

Field 11 (F10): Numerical value of selected normal boundary condition at collocation 

point 2 

Material Constitutive Model for Potential Crack Segments (defined as many lines as 
needed) 

φR 

φο 

Co

CR 

To 

Cohesion 

Tensile 
Strength 

Failure envelope

Residual failure 

τ = a(σt –σn)b 

τ = S – tan(φ)σn 

S = Co – Csof t |Ds| 

σt = To – Tsof t |Dn| 
    = 0   if    Dn >  

Figure A-4. Mohr Coulomb type of failure. 
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Field  1 (A1): Record type character = ‘C’ 

Field  2 (A1): Single character for a material constitutive code. 

Field  3 (A1): Format selection character for constitutive model 

(Set character = blank). The constitutive definition is applied to both 

collocation points in any discontinuity segment that refers to this 

definition. 

Field  4 (F5): Crack width (must be set = 0 for crack or fault definition) 

Field  5 (F6): Initial intact cohesion, Co (MPa) 

Field  6 (F6): Initial intact friction angle, φo (Degree) 

Field  7(F6): Initial sliding dilation angle, ψo (Degree) 

Field  8(F6): Residual cohesion, CR (MPa) 

Field  9(F6): Residual friction angle, φR (MPa) 

Field 10(F6): Reverse dilation angle relative to initial sliding direction, ψR (Degree) 

Field 11(F6): Tension cut off, To (MPa) 

Field 12(F6): Opening crack limit over which tensile strength is lost, DNCR (This defines 

implicitly the tension softening slope, Tsoft = To/DNCR, with respect to the 

opening crack limit. 

Field 13(F6): Cohesion softening slope, Csoft (MPa / mm) 

Field 14(F6): Tension softening slope, Tsoft (MPa / mm). Note that the specification of 

both DNCR and Tsoft is redundant. This arises from the possible provision of 

a non-linear tension-weakening law not described here. The non-linear 

model is still in experimental process. 
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Field 15(F9): Parameter LAMDA.  It is a exponent in tension weakening law controlling 

residual tensile strength as a function of crack opening. LAMDA = 1 for 

linear tension weakening (default) 

Field 16 (F8): Viscoelastic parameter 1, VP1 (mm/(s.MPa) ).  It is proportionality 

constant in relaxation creep law or may be ignored if creep not being 

simulated. 

Field 16 (F8): Viscoelastic parameter 2, VP2.  It is an exponent in creep law or ignored if 

creep not simulated. 

Processing Step  (defined as many lines as needed) 

Field  1 (A1): Processing step header specification (‘!’) 

Field  2 (A1): Single character for determining crack grow rule 

‘P’ = parallel crack growth rule for each incremental growth step 

‘I’ = incremental (or sequential) crack growth rule for each incremental 

growth step 

Field  3 (A4): Step identification name 

Field  4 (F6): Message skip interval for reporting iteration convergence status ( ≥ ) 1

Field  5 (F6): Maximum number of crack growth search increments per time step 

interval ( ) 0≥

Filed  6 (F6): Number of time steps associated with the current processing step ( ) 0≥

Field  7 (F6): Time step size in chosen “time” units 

Field  8 (F6): Stress tolerance for solution iteration (MPa) 

Field  9 (F6): Field not used – set to zero 

Field 10 (F6): Maximum number of iterations allowed in each solution cycle 

Field 11 (F6): Iteration relaxation factor, ω  (suggest 4.0=ω ) 
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Field 12 (A2): Step “color” code character 

Field 13 (A2): Selection code for iterative solution routine, right justified 

= ‘#’ - Lanczos-1-Delayed 

= ‘%’ - Lanczos-2 scheme 

= ‘G’ - Gauss-Seidel 

= ‘J’ - Jacobi     

Processing Step Element Report Request (defined as many lines as needed within the 
current processing step) 

Field  1 (A1): Record type character = ‘R’ 

Field  2 (A1): Report type code 

= ‘A’ – report only active elements. 

= ‘X’ – report all elements. 

= ‘S’ – report energy release 

Field  3 (A4): Segment selection mask code – this field is optional and can be used to 

select element reports on segments that match non-blank characters in the 

mask code 

Processing Step Field Point Report Request (defined as many lines as needed within the 
current processing step) 

Field  1 (A1): Record type character = ‘R’ 

Field  2 (A1): Report type code 

= ‘C’ – report stress component in Cartesian coordinates 

= ‘G’ – report stress components in principal directions  

Both ‘C’ and ‘G’ report displacement components in global Cartesian 

coordinates  

Field  3 (F4): Number of field points in Y-axis direction 
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Field  4 (F4): Number of field points in Z-axis direction 

Field  5 (F4): Origin field point coordinate Yo 

Field  6 (F4): Origin field point coordinate Zo 

Field  7 (F4): Angle of a line of field points, in degrees, measured positive from global 

Y-axis towards global Z-axis 

Field  8 (F4): Incremental distance between field points in Y direction 

Field  9 (F4): Incremental distance between field points in Z direction 

End of Input Data Marker (defined in one line) 

Field  9 (A2): Record type character = ‘//’.  

Comment record (defined as many lines as needed) 

Any record starting with the characters ‘**’ is ignored and treated as a comment. 

Example 3: Square Plate with a Circular Hole (PLATE_H.DAT) 

A square plate with a circular hole shown in Figure A-5 is subjected to uniaxial 

tension. The elastic background material has Young’s Modulus = 6000 MPa and 

Poisson’s ratio = 0.2.  Five boundary condition codes (T, D, B, C and A) are defined for 

ordinary boundary segments on the edges of square plate and the inner circle.  Two 

material constitutive codes (M and V) are defined for potential crack segments that form 

Voronoi with internal fracture path tessellation. All segments used for this problem are 

defined in the segment file PLATE_H2.VSG, which was created by using the PRE 

processor to edit boundary condition codes for ordinary boundary element and material 

constitutive codes for potential crack elements in the PLATE_H.VSG. 

The square plate is fixed at the bottom and pulled upward 0.05 mm for 5 load steps.  

In the first load step LD00, request energy release report (RS) and all element report 

(RX).  In subsequent load steps (LD01, LD02, LD03, LD04 and LD05), request energy 
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release report (RS), active element report (RA), ‘Linear’ field point report in principal 

direction (RG) and ‘Matrix’ field point report in Cartesian coordinate (RC). 

 
 
Figure A-5. Square plate with a circular hole for the data file. 

Here are the codes written in PLATE_H.DAT file for this problem. 

PLATE_H.DAT 

**************************************************************************** 

***                              DAT file                                *** 

**************************************************************************** 

** 

**...GENERAL PARAMETERS 

**      YM      PR      GY      GZ     CYY     CYZ     CZZ     CPP    PPGR 

PR    6000     0.2       0       0       0       0       0       0       0 
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VTCST         0         0N+     -0.01     -0.01 

VDCS+         0         0N+     -0.01     -0.01 

CBCST         0         0N+         0         0 

CCCS+         0         0N+         0         0 

CACST         0         0NT         0         0 

** 

**   WID   COH   FRN   DIL  FCOH  FFRN  RDIL  TCUT  DNCR CSOFT TSOFT#   LAMDA VP1   VP2 

CM     0     3    35     0   0.1    20     0     3  0.05    60    60        1   0     1 

CV     0     6    35     0   0.1    20     0     6  0.02   300   300        1   0     1 

** 

**STEP MSKIP MXINC MXSTP TSTEP  TTOL  DTOL MAXIT   SOR C S 

!PLD00    10    10     1     1 0.005     0   250   0.4 B # 

I PLATE_H2.VSG 

RX 

RS 

!PLD01    10    10     1     1 0.005     0   250   0.4 B # 

RA 

RS 

RG  10   1      15       0       0  3.8889       0 

RC  11   8       0     -50       0       5       5 

!PLD02    10    10     1     1 0.005     0   250   0.4 B # 

RA 

RS 

RG  10   1      15       0       0  3.8889       0 

RC  11   8       0     -50       0       5       5 

!PLD03    10    10     1     1 0.005     0   250   0.4 B # 

RA 

RS 

RG  10   1      15       0       0  3.8889       0 

RC  11   8       0     -50       0       5       5 

!PLD04    10    10     1     1 0.005     0   250   0.4 B # 

RA 

RS 

RG  10   1      15       0       0  3.8889       0 

RC  11   8       0     -50       0       5       5 

!PLD05    10    10     1     1 0.005     0   250   0.4 B # 
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RA 

RS 

RG  10   1      15       0       0  3.8889       0 

RC  11   8       0     -50       0       5       5 

// 

A.3.4 Output File (*.OUT) 

The OUT file contains the analysis result obtained from DIGS.  The OUT file first 

echoes the information in the DAT file and subsequently reports the requested output 

variables at elements and field points for each load step. The output variable names will 

be explained in three subsets: 

• Output variables at element (requested with command code ‘RX’ or ‘RA’) 
• Output variable at field point (requested with command code ‘RC’) 
• Output variables at field point (requested with command code ‘RG’) 

 

Output Variables at Element (Requested with Command Code ‘RX’ or ‘RA’) 

The output variables below are reported at two collocation points (YC, ZC) for 

each element being requested. 

ANG  = Angle (degree) measured from Y-axis to Z-axis 

TYY+  = Local tangential stress yy component (MPa) on positive side 

TYY-  = Local tangential stress yy component (MPa) on negative side 

TYZ  = Local shear stress yz component (MPa) 

TZZ  = Local normal stress zz component (MPa); tension positive 

COH  = Cohesion strength (MPa) 

DY  = Sliding crack displacement (mm*1000) 

DZ  = Opening crack displacement (mm*1000) 
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FW/DL = Either Fill Width (ignore - for mining applications) or crack dilation 

(mm*1000) - crack opening induced by sliding if a dilation angle is 

specified. 

UY+  = Local displacement in y direction (mm*1000) measured on positive side 

UZ+  = Local displacement in z direction (mm*1000) measured on positive side 

CODE = A letter code (either boundary condition code or material constitutive 

code for the element being reported. 

Output Variables at Field Point (Requested with Command Code ‘RC’) 

MAJOR = Major principal stress (MPa); tension positive 

MINOR = Minor pricipal stress (MPa) ; tension positive 

MAJ.ANG  = Major angle (degree) measured from Y-axis to Z-axis 

UY  = Global displacement in Y-direction (mm*1000) 

UZ  = Global displacement in Z-direction (mm*1000) 

DMC  = Distance to a Mohr-Coulomb envelope (MPa) 

SED  = Strain energy density (MPa) 

Output Variables at Field Point (Requested with Command Code ‘RG’) 

TYYB   = Normal stress YY component (MPa) in global Cartesian coordinate. 

TYZB  = Shear stress YZ component (MPa) in global Cartesian coordinate. 

TZZB  = Normal stress ZZ component (MPa) in global Cartesian coordinate 

UYB  = Displacement in Y-direction (mm*1000) in global Cartesian coordinate 

UZB  = Displacement in Z-direction (mm*1000) in global Cartesian coordinate 

ESS = Excess shear stress (MPa). This is the absolute shear stress across an 

element minus the frictional resistance (friction coefficient*normal stress). 
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A.3.5 Request File (*.REQ) 

The REQ file is a text file containing request command codes to report output 

variables at each load step to the report file (*.RPT).  The request command codes are 

written in free field format; separate each field with comma “,”.  If more than one line of 

request command code is needed, place a comma “,” at the end of the line before 

continuing to the next line.  The structure of REQ file consists of any of these coding 

blocks (not in particular order). 

• Request output variables at elements 
• Request output variables at field points (Cartesian coordinate ‘RC’) 
• Request output variables at field points (Principal coordinate  ‘RG’) 
 
Request Output Variables at Elements 

[‘EL’] 

[Number of load step requested], [number of lines defining load step names] 

[Load step names (separate load step name with comma “,”) 

. {Continue to next line if needed} 

. 

] 

[Number of elements requested], [number of lines defining element numbers] 

[Element numbers (separated element number with comma “,”) 

.  {Continue to next line if needed} 

. 

] 

[Number of output variable names requested], [Number of lines defining output variable 

names] 
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[Output variable names such as YC, ZC, ANG, TYY+, TYY-, TYZ, TZZ, COH, DY, 

DZ, FW/DL, UY+, UZ+, CODE (separated by comma ‘,’) 

.  {Continue to next line if needed} 

. 

] 

Request Output Variables At Field Points (Cartesian Coordinate ‘RC’)  

[‘RC’] 

[Number of load steps requested], [number of lines defined load step names] 

[Load step names (separate load step name with comma) 

.  {Continue to next line if needed} 

. 

] 

[Number of coordinates requested] 

[Coordinate Y1, Coordinate Z2] 

. 

[Coordinate Yn, Coordinate Zn] 

[Number of output variable names requested], [Number of lines defining output variable 

names] 

[Output variable names such as TYYB, TYZB, TZZB, UYB, UZB, ESS (separated with 

comma) 

.  {Continue to next line if needed} 

] 

Request Output Variables at Field Points (Principal Coordinate  ‘RG’)  

[‘RG’] 
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[Number of load steps], [number of lines defining load step names] 

[Load step names (separate load step name with comma) 

.  {Continue to next line if needed} 

. 

] 

[Number of coordinates requested] 

[Coordinate Y1, Coordinate Z2] 

[Coordinate Y2, Coordinate Z2] 

. 

. 

[Coordinate Yn, Coordinate Zn] 

[Number of output variable names requested], [Number of lines defining output variable 

names] 

[Output variable names such as MAJOR, MINOR, MAJ.ANG, UY, UZ, DMC, SED 

(separated with comma) 

.  {Continue to next line if needed} 

. 

] 
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Example of request file (*.REQ) 

EL    -Request output variables at DD elements  

4, 1    -4 load steps defined in 1 line 

L010, L020, L030, L040 -Load step name (CAPITAL) 

8, 1    -8 number of elements defined in 1 line 

1, 2, 3, 4, 5, 6, 7, 8  -Element numbers 

4, 1    -4 output variables defined in 1 line 

YC, ZC, TYZ, TZZ  -Name of output variables (CAPITAL) 

RG    -Request output variables at field points  

8, 2    -8 load steps defined in 2 line 

L010, L020, L030, L040, -Load step names and use “,” at the end of  

L050, L060, L070, L080 -line to continue to next line 

3    -3 coordinates 

-75.000, 0.000  -Coordinate (Y1,Z1) 

-72.000, 0.000  -Coordinate (Y2,Z2) 

-69.000, 0.000  -Coordinate (Y3,Z3) 

5, 2    -5 output variables defined in 2 line 

MAJOR, MINOR, MAJ.ANG,  -Name of output variables (CAPITAL) and use  

UY, UZ   -“,” at the end of line to continue next line 

//    -“//” for ending request  

Note that “-” at each line is used for the explanation purpose. Users should not use in 

the REQ file. 

A.3.6 Report File (*.RPT) 

The RPT file is a result of using the request file (*.REQ) to request the output 

variables stored in the POST processor.  The requested output variables are written in 

fixed field format, convenient to be opened with Spreadsheet program such as Excel. 
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A.4 The PRE/POST Processor (DDM) 

PRE/POST processor was developed to help users create input and read output 

files.  It assumes that users are familiar with window applications. Therefore, the manual 

will briefly explain only the functionality of the selections on menu bar and special 

features.  In addition to the menu bar, the commonly tasks used in the program are 

provided in the tool bar for convenience. 

PRE/POST processor provides a temporary workspace for several files (*.IN, 

*._SG, *.DAT, *.OUT).  For each file opened, the information from that particular file 

will be loaded to the temporary workspace available for user to edit and save it back to 

the file where it belongs. 

A.4.1 Symbols and Terminologies 

[Menu] -> [Submenu] refers to the processes that the user selects a menu from a 

menu bar and then select one of its submenu.  

<Key or Event> refers to a particular key on keyboard or an event acted by mouse.  

For example <Shift> + <Left Click> refers to the event that user hold <Shift> key and 

press <Left Click> on the mouse. 

“Entity” here refers to one of these 4 objects (‘Line’ segment, ‘Circular’ segment, 

‘Linear’ field point and ‘Matrix’ field point).  These entities can be create, edit, and 

delete within the PRE processor. 

“Highlight” (with pink color) happens when placing cursor over an entity.  It 

indicates that the highlighted entity is temporarily selected.  The selected entity can be 

processed with other commands by <Right Click> to open the cursor menu that contains 

Cut, Copy, Paste, Move, Send to Back, Edit Segment, Break Segment, Flip and Delete. 
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“Dark Highlight” (with dark pink color) happens when placing cursor over an entity 

and press <Shift> + <Left Click>.  It indicates that the highlighted entity is permanently 

selected.  When moves cursor away from the highlighted entity, the color of entity will 

appear dark pink.  Users can add more selected entities by repeating the processes; place 

cursor over the desired entity and press <Shift> + <Left Click>.   

A.4.2 Menu Bar 

Figure A-6 shows the PRE/POST processor menu bar.  It consists of File, Edit, 

View, Tessellation, Geometry, Field Point, Boundary, Material, Load Step, Display and 

Help.  The common tasks available in menu bar are also provided in tool bar for 

convenience. 

 
 
Figure A-6. The DDM menu bar. 

[File] 

Menu [File] has 5 submenus [New], [Open], [Save All], [Save As] and [Exit].  

 



114 

[File] -> [New]    

Pop up ‘Warning Dialog Box’ asking the user to save the opened files before 

creating new information in workspace.  If select [Yes], the program will save all opened 

files (*.IN, *._SG and  *.DAT).  If select [No], the program will not save any information 

before working with new workspace.  If select [Cancel], nothing happens. 

[File] -> [Open]   

Pop up ‘Open Dialog Box’ asking the user to open one of these 4 file types (*.IN, 

*._SG *.DAT and *.OUT).  The program will read information from each file and fill 

that information in workspace. The graphical information such as segments will be 

displayed graphically in window screen while non-graphical information such as 

boundary conditions will be placed in a particular dialog box such as ‘Boundary 

Condition Dialog Box’. The user can modify and save the information to the existing file 

or to the new file. 

[File] -> [Save All]  

Pop up ‘Save As Dialog Box’ asking the user to save or not to save three file types 

(*.IN, *._SG *.DAT).  The PRE processor can open up to 4 different files (*.IN, *._SG 

*.DAT and *.OUT) at the same time for convenience reason.  The information of first 

three files that associate with the PRE processor will be saved to the files where it 

belongs. 

[File] -> [Save As]  

Pop up ‘Save As Dialog Box’ asking the user to save or not to save one of these 3 

files (*.IN, *.XSG *.DAT). 
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[File] -> [Exit] 

Pop up ‘Warning Dialog Box’ asking the user to save files before leaving the 

program. User has the last chance to save or not to save the information on workspace. 

[Edit] 

Menu [Edit] has 13 submenus [Selecting Window], [Select Element Group],  

[Deselect All], [Cut], [Copy], [Paste], [Move], [Send to Back], [Edit], [Break Segment], 

[Flip], [Delete] and [Clear]. 

[Edit] -> [Selecting Window]   

Turn on/off ‘Selecting Window’ mode.  When the mode is on, the user can select 

several entities by pressing <Left Mouse Button> and drag to create a rectangular 

window crossing those entities.  After releasing the mouse button, those entities will be 

permanently selected (dark highlighted) available for other operations to proceed. 

[Edit] -> [Select Element Group] 

Pop up ‘Select Element Group Dialog Box’ shown in Figure A-7 and ask the user to 

select element groups by specify boundary condition codes for ordinary boundary 

segments and/or material constitutive codes for potential crack segments. The segments 

that have the specified codes will be permanently selected (dark highlighted) available for 

other operations to proceed. 
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Figure A-7. Select element group dialog box. 

[Edit] -> [Deselect All]   

Clear the ‘selected ’status for all previous permanently selected entities and also 

turn off other modes (‘Move’, ‘Pan Center’, ‘Probe’ and ‘Zoom Window’). 

[Edit] -> [Cut]   

Remove the selected entities and place them to a temporary memory. 

[Edit] -> [Copy]   

Copy the selected entities to a temporary memory. 

[Edit] -> [Paste]   

Paste the selected entities that exist in the temporary memory at the center of the 

screen.  All entities still remain highlighted so other operation such as ‘Move’ can 

continue.  
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[Edit] -> [Move] 

Turns on/off ‘Move’ mode.  When the mode is on, the user can drag the highlighted 

entities to any desired locations. Move mode can also be turned off by [Edit]-> [Deselect 

All]. 

[Edit] -> [Send To Back] 

Send the selected entities to the back.  The last drawn entities will be placed on the 

top of the previous drawn entities.  If the user wants to select the entities that have other 

entities in front of them, those entities in the front must be sent to the back. 

[Edit] -> [Edit] 

Pop up a specific edit dialog box (‘Linear Segment Dialog Box’, ‘Circular Segment 

Dialog Box’, ‘Linear Field Point Dialog Box’ and ‘Matrix Field Point Dialog Box’) for 

each type of entity selected.  If more than one entity is selected, the ‘Multiple Edit 

Segment Dialog Box’ will be opened.  The user can then edit properties of each selected 

entity. 

[Edit] -> [Break Segment] 

Break ‘Line’ or ‘Circular’ segments into small ‘Line’ segments according to 

number of elements per segment specified. 

[Edit] -> [Flip] 

Flip the direction of the selected entities (‘Line’ segment, ‘Linear’ and ‘Matrix’ 

field output).  Start point becomes end point and end point becomes start point. 

[Edit] -> [Delete] 

Delete the selected entities from the workspace. 
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[Edit] -> [Clear] 

Clear has 9 submenus [Tessellation], [Segment], [Field Point], [Boundary 

Condition], [Base Material], [Cemented Material], [Step], [All Components in PRE 

Processor] and [All Components in POST Processor]. 

[Edit] -> [Clear] -> [Tessellation]  

Clear the information specified in ‘Tessellation Dialog Box’.  

[Edit] -> [Clear] -> [Segment] 

Delete all segments (‘Line’ and / or ‘Circular’) from workspace. 

[Edit] -> [Clear] -> [Field Point] 

Delete all field points (‘Linear’ and / or ‘Matrix’) from workspace. 

[Edit] -> [Clear] -> [Boundary Condition] 

Delete all boundary conditions defined in ‘Boundary Condition Dialog Box’. 

[Edit] -> [Clear] -> [Base Material] 

Clear the information of background material and primitive stress field parameters 

defined in ‘Base Material Dialog Box’. 

[Edit] -> [Clear] -> [Cemented Material] 

Delete all material constitutive codes defined in ‘Cemented Material Dialog Box’. 

[Edit] -> [Clear] -> [Load Step] 

Delete all processing steps (load steps) defined in ‘Load Step Dialog Box’. 

[Edit] -> [Clear] -> [All Components in PRE Processor] 

Delete all components associated with the PRE processor (tessellation, segment, 

field point, boundary condition, base material, cemented material and load step). 
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[Edit] -> [Clear] -> [All Components in POST Processor] 

Delete all components associated with the POST processor so that the new output 

file can be opened. 

[View] 

Menu [View] has11 submenus [Model Settings], [Zoom In], [Zoom Out],  

[Zoom Window], [Zoom All], [Pan Center], [Show Boundary Condition Code],  

[Show Material Constitutive Code],  [Show Direction of Segment], [Tool bar],  

[Status Bar]. 

[View] - > [Model Settings] 

Pop up ‘Model Setting Dialog Box’ shown in Figure A-8.  The user can specify the 

‘Left Top’ and ‘Right Bottom’ corner of the model in Y-Z coordinate, grid size, snap 

size, the decimal point used, turn on/off the grid and snap mode. 

 
 

Figure A-8. Model setting dialog box. 
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[View] - > [Zoom In]   

Enlarge the view by 20% of the original model size. 

[View] - > [Zoom Out]   

Decrease the view by 20% of the original model size. 

[View] - > [Zoom Window]   

Turn on/off ‘Zoom Window’ mode.  When the mode is on, left click and drag a 

rectangular window over the area of interest. 

[View] - > [Zoom All] 

Adjust the zoom mode to view an entire model size. 

[View] - > [Pan Center]   

Turn on/off the ‘Pan Center’ mode. When the mode is on, right click at the location 

to be viewed at the centre of computer screen. ‘Pan Center’ mode can also be turned off 

by [Edit]-> [Deselect All]. 

[View] -> [Show Boundary Condition Code]   

Turn on/off the ‘Show Boundary Condition Code’ mode.  When the mode is on, the 

ordinary boundary segments will show their boundary condition codes.   

[View] -> [Show Material Constitutive Code]   

Turn on/off the ‘Show Material Constitutive Code’ mode. When the mode is on, 

the potential crack segments will show their material constitutive codes. 

[View] -> [Show Direction of Segment]   

Turn on/off the ‘Show Direction of Segment’ mode.  When the mode is on, the 

‘Line’ segments will show their directions with arrows from the start point to the end 
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point and the ‘Circular’ segment will show the clockwise direction.  The direction of the 

‘Line’ segment can be flipped by [Edit]->[Flip], but the direction of ‘Circular’ segment 

cannot be flipped.  The ‘BCB’ command used in the IN file always construct segments 

along circumference in clockwise direction.  To create segment in counter clockwise 

direction, user may break ‘Circular’ segment to several small ‘Line’ segments along its 

circumference with [Edit]->[Break] and then [Edit]-> [Flip] those ‘Line’ segments. 

[View] -> [Tool Bar] 

Turn on/off the tool bar. 

[View] -> [Status Bar] 

Turn on/off the status bar. 

[Tessellation] 

Menu [Tessellation] has 2 submenus [Create] and [Export Segment]. 

[Tessellation] -> [Create] 

Open ‘Tessellation Dialog Box’ shown in Figure A-9 for the user to input the data 

needed for generating tessellation.  The information in ‘Tessellation Dialog Box’ will be 

saved to the input file (*.IN).  
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Figure A-9. Tessellation dialog box. 

[Tessellation] -> [Export Segment] 

Open ‘Export Segments Dialog Box’ shown in Figure A-10 for the user to export 

ordinary boundary segments and/or potential crack segments to the segment file (*._SG) 

by giving their boundary condition codes and/or material constitutive codes in the order 

of the segments to be written in the segment file.  
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Figure A-10. Export segment dialog box. 

[Geometry] 

Menu [Geometry] has 2 submenus [Line] and [Circle]. 

[Geometry] - > [Line] 

Turn on the drawing mode for ‘Line’ segment.  Press <Left Mouse Button> and 

drag from the start point to the end point to create a ‘Line’ segment.  Its properties can be 

edited by placing cursor over the segment and right click to open the cursor menu, then 

select [Edit].  Figure A-11 shows ‘Line Segment Dialog Box’.  

If the letter code for the segment is specified, the ‘Line’ segment will be saved in a 

segment file. A letter code refers to the boundary condition code for ordinary boundary 

segment and material constitutive code for potential crack segment.  If the letter code is 

omitted, the segment will be considered as a part of the boundary regions and will be 

saved to the input file (*.IN). 
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Figure A-11. Line segment dialog box. 

[Geometry] - > [Circle] 

Turn on the drawing mode for ‘Circular’ segment.  Press <Left Mouse Button> and 

drag from center point to the point on circumference to create a ‘Circular’ segment. It can 

be edited by placing cursor over the segment and right click to open the cursor menu and 

select [Edit].  Figure A-12 shows ‘Circular Segment Dialog Box’. 

The ‘Circular’ segment cannot be saved in a segment file (*._SG) that contains 

only ‘Line’ segments.  However, users can break a ‘Circular’ segment with  

[Edit]->[Break Segment] to ‘Line’ segments along circumferences and save them to the 

segment file.  If the letter code for ‘Circular’ segment is omitted, it will be considered as 

a part of the boundary region and will be saved to the input file (*.IN). 
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Figure A-12. Circular segment dialog box. 

[Field Point] 

Menu [Field Point] has of 2 submenus [Linear] and [Matrix] 

[Field Point] - > [Linear] 

Turn on the drawing mode for ‘Linear’ field point (a straight line of field points 

requested in a DAT file.  Press <Left Mouse Button> and drag from start point to end 

point to create a ‘Linear’ field point.  It can be edited by placing cursor over the field 

point and right click to open the cursor menu and select [Edit].  Figure A-13 shows 

‘Linear Field Point Dialog Box’. 
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Figure A.13. Linear field point dialog box. 

[Field Point] - > [Matrix] 

Turn on the drawing mode for ‘Matrix’ field point (a matrix of field points 

requested in a DAT file).  Press <Left Mouse Button> and drag from start point (top left 

corner) to end point (bottom right corner) to create a ‘Matrix’ field point.  It can be edited 

by placing cursor over the field point and right click to open the cursor menu and select 

[Edit].  Figure A-14 shows ‘Matrix Field Point Dialog Box’.  

 
 

Figure A-14. Matrix field point dialog box. 
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[Boundary] 

Menu [Boundary] has 1 submenu [Manager]. 

[Boundary] -> [Manager] 

Open ‘Boundary Condition Dialog Box’ shown in Figure A-15 for the user to 

operate boundary conditions.  Boundary condition code is defined by a single character.  

The color for boundary code can be set with a conventional RGB color method – 

combined red, green and blue color.  The intensity of each color can be set from 0 to 255.  

The boundary type can be either ‘Constant’ if it does not change with time step or 

‘Velocity’ if it does.  Boundary condition can be set to one of these four conditions: 

displacement on positive side, displacement on negative side, traction and discontinuity.  

For every boundary element, there are two collocation points.  The value on each 

collocation point will have the meaning according to boundary condition specified such 

as traction = 0 means traction free surface condition.  The dialog has 6 buttons at the 

bottom, in which their functions will be described below. 

[New] = Clear information in all text boxes so that the user can input new 

information 

[Add] = Add the boundary condition to the boundary code list 

[Delete] = Delete the boundary condition from the boundary code list 

[Save Edit] = Save the edited data 

[OK]  = Save the edited data and leave the dialog box 

[Cancel] = Cancel action made to the dialog box 
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Figure A-15. Boundary condition dialog box. 

[Material] 

Menu [Material] has 2 submenus [Base Material] and [Cemented Material]. 

[Material] -> [General Parameters] 

Open ‘General Parameter Dialog Box’ shown in Figure A-16 for the user to input 

and/or edit general parameters for background elastic material and associated stress 

fields. 
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Figure A-16. General parameter dialog box. 

[Material] -> [Cemented Material] 

Opens ‘Cemented Material Dialog Box’ shown in Figure A-17 for the user to 

operate material constitutive codes used in the model.  The material constitutive code is 

defined by a single character. The color for each material code can be set by a 

conventional RGB color method.  The dialog box has 6 buttons [New], [Add], [Edit] 

[Save Edit], [OK] and [Cancel] at the bottom in which their functionalities are similar to 

those in ‘Boundary Condition Dialog Box’. 
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Figure A-17. Cemented material dialog box. 

[Load Step] 

Menu [Load Step] has 2 submenus [Create] and [Include Segment File]. 

[Load Step] -> [Create] 

Open ‘Load Step Dialog Box’ shown in Figure A-18 for user to operate load steps.  

The dialog box has 6 buttons [New], [Add], [Edit], [Save Edit], [OK] and [Cancel] at the 

bottom in which their functionalities are similar to those in ‘Boundary Condition Dialog 

Box’. 
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Figure A-18. Load step dialog box. 

[Load Step] -> [Include Segment File] 

Open ‘Include Segment File Dialog Box’ shown in Figure A-19 for the user to 

enter the segment file name (*._SG) to be included in the DAT file.  The PRE processor 

requires all segments used in the problem be defined in a segment file.  The PRE 

processor will attach this segment file name to the DAT file.  Even though DIGS allow 

segments to be defined within the DAT file, the PRE processor will not recognize that 

format. 
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Figure A-19. Include segment file dialog box. 

[Display] 

Menu [Display] has 6 submenus [Display Result], [Setting], [Probe],  

[Previous Load Step], [Next Load Step] and [Request Output Variables]. 

[Display] - > [Display Result] 

Submenu [Display Result] has 2 small submenus [DD Element Only] and  

[DD Element with Filed Point].  

[Display] - > [Display Result] -> [DD Element Only] 

Display the result of displacement discontinuity (DD) element only. Users can view 

the geometry, deformation and crack propagation. 

[Display] - > [Display Result] -> [DD Element with Field Point] 

Display the result of displacement discontinuity (DD) element and field points. 

Users can view geometry, deformation, crack propagation and field points. 

[Display] - > [Setting] 

Submenu [Setting] has 3 small submenus [Amplification], [Color] and  

[Probe Options]. 

[Display] - > [Setting] ->[Amplification] 

Open ‘Amplification Dialog Box’ shown in Figure A-20. User can set the scale to 

amplify the deformation and opening crack for visualized purpose. 
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Figure A-20. Amplification dialog box. 

[Display] - > [Setting] ->[Color] 

Open ‘Color for DD Element Dialog Box’ shown in Figure A-21. User can set a 

color for each group of DD element based on its letter code (boundary condition code for 

ordinary boundary element and material constitutive code for potential crack element). 

 
 

Figure A-21. Color for DD element dialog box. 

[Display] - > [Setting] ->[Probe Options] 

Open ‘Probe Option Dialog Box’ shown in Figure A-22.  User can select one of 

these 3 probing options: (1) Probe DD element, (2) Probe field point in principal 

direction and (3) Probe field point in Cartesian coordinate.  For each option, user can 

select the desired output variables to be monitored by marking those variables.  
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Figure A-22. Probe option dialog box 

[Display] - > [Probe] 

Turn on/off ‘Probe’ mode.  When ‘Probe’ mode is turned on, the user can probe the 

output variables according to the probing option by placing cursor close to the collocation 

of the DD element or close to the location of field point. 

[Display] - > [Previous Load Step]   

Go back to the previous load step and view the result. 
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[Display] - > [Next Load Step]   

Forward to next the load step and view the result. 

[Display] - > [Request Output Variables] 

Open ‘Request Output File Dialog Box’ shown in Figure A-23.  The dialog box 

asks the user to enter the request output file (*.REQ) and the report output file (*.RPT).  

 
 

Figure A-23. Request output file dialog box. 

[Help] 

Menu [Help] has one submenu [About DDM] 

[Help] - > [About DDM]   

Pop up ‘About DDM Dialog Box’ describing the PRE/POST program DDM. 
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